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Quick Start

This chapter is provided as a reference and a simplified introduction and operation guide for
DataDesigner software. See subsequent chapters in this manual or the online help provided with
DataDesigner for more detailed information and explanation.

Installing DataDesigner Software
DataDesigner is designed to install and run under Windows  95, Windows 98 , Windows NT 4.0,
or Windows 2000.

Insert DataDesigner Disk 1 in the floppy drive. Click START, RUN. Type floppy drive letter +
:SETUP. Press . Follow the instructions on the screen. Change the disks when prompted. (For
more detailed information, refer to Chapter 3, “Getting Started.”)

To run the Setup application from Windows Explorer, click on the Explorer icon after you have
inserted the DataDesigner Disk 1 in the floppy drive.  Scroll to the applicable floppy drive
directory listing, and double-click on the setup.exe file. Follow the instructions on the screen.
Change the disks when prompted.  Using Windows 95, you can run the Setup application by
selecting START, then RUN.

Starting DataDesigner
If a Start menu entry was created, select, Start, then select Programs, and DataDesigner. If not,
click START, RUN, type “c:\DataDesigner\DataDsgn.exe”, and press . (For more detailed
information, refer to Chapter 3, “Getting Started.”)

Using Online Documentation
 DataDesigner software includes detailed Help topics that are loaded onto the hard disk of your

computer during the software installation procedure and are readily accessible. To see the Help
contents or search for a topic using the index, go to the Help menu. To see a topic specific to the
active window or dialog box, click the Help button or icon provided on the window or dialog box.

1
Chapter
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Using DataDesigner to Configure a Datapanel
The configuration of a Datapanel involves four main steps:

1. Creating a database and configuring
its parameters.

To create a new database, go to the File
menu or the Project menu, and select
New Project. The New Project dialog
box will appear. Select the Database
Type (the Datapanel model for which
you are creating the database) from the
pull-down list. Type the name of the
database you want to create in the Project Name field and click OK. The Protocol and Port
Settings dialog box will appear.

You must configure at least one channel for Datapanel-controller communications. (You can
specify up to two protocols through two different communications ports.)

Other database parameters consist of System Settings (on the Datapanel menu). Details for
configuring channels and protocols are provided in Chapter 4, “Setting up the Datapanel
Database.” Advanced information about Datapanel communications is provided in Chapter 9,
“Configuring Datapanel Communications.”

Note: To delete a database, use Windows Explorer to delete the folder from
the DataDesigner DBASE folder. (You cannot delete a database that is
currently open in DataDesigner, and you must exit DataDesigner before
deleting the folder or select a different database from the one to be
deleted.)
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2. Defining the analog and digital tags indicating the points to be monitored or controlled.

To configure tags, select Tags from
the Project menu, or click the Tag
button on the DataDesigner main
toolbar. The Tag Editor will appear.

(Analog and digital recipe tags are
also configured from the Tag Editor.
Be sure to specify which channel
your addresses are to be used on.
This must coincide with the protocol
and channel specified in step 1. For
details about configuring tags, refer
to Chapter 5, “Configuring Tags,
Groups, and Message Tables.”

3. Configuring the graphic page displays.

To configure graphic pages, select Graphic Pages from the Project menu or click the Graphic
Pages button on the Toolbar. An empty graphic page is displayed by default when you create a
new project. (The features presented in this window depend on the database type.) For an
overview, refer to Chapter 6, “Initial Page Design.” For details on creating graphic objects,
refer to Chapter 7, “Displaying Information on the Page.” For details on configuring objects
that allow operator input, refer to Chapter 8, “Configuring Operator Input.”
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4. Transferring (downloading) the database to the Datapanel.

To download the database, use the supplied download cable to connect the DataDesigner
computer to the Datapanel and put the Datapanel in Host Transfer mode. To put the Datapanel
into Host Transfer Mode, press the Mode key (F5), followed by the Offline key (F6) and then
the Transfer key (F5). If the Mode key is not available, Datapanels of version 5.1 or later may
be forced into Host Transfer Mode by starting the GoTo Transfer command in the Transfer
utility (Special menu), then power cycle the panel. The panel will come up in Host Transfer.
For earlier versions, refer to the user's manual for your specific Datapanel.

For details on the Datapanel Transfer Utility, refer to Chapter 10, “Loading Your Datapanel.”

Note: Datapanels are shipped from the factory without any system software
(.cmd file).  If your Datapanel needs system software, the startup screen
displays the message “Waiting for Software.” Some models also display
“Checksum Error,” which does not indicate that there is a fault with the
panel, just that it needs a .cmd file.

If you attempt to download a database to a Datapanel that does not have
system software, a screen prompting you to load a .cmd file appears.
When you click OK, a file selection dialog listing the .cmd file for your
Datapanel model appears. When you select the .cmd file, it is loaded and
the database and/or protocol download proceeds automatically.
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Introduction

This chapter provides an overview of the configuration procedure. The following topics are
presented:

•  Overview of Datapanels

•  Overview of DataDesigner Software

•  Data Flow Between the Controller and the Datapanel

•  Analog and Discrete Data

•  Scaling of Raw Data

•  Configuration Procedure

Overview of Datapanels
Datapanels provide a low-cost human-machine interface for transferring control data between the
Datapanel and a programmable logic controller (PLC) or other intelligent control device.
Datapanels are self-contained, solid state industrial display systems incorporating their own display
screens and keypads. Each unit forms a comprehensive operator terminal or message center. A
wide range of communication capabilities is provided and an extensive list of controller protocols
is supported. In order to utilize the capabilities of the Datapanel, the Datapanel must be configured
for each specific application. The DataDesigner software is used to perform this configuration.

Overview of DataDesigner Software
DataDesigner software is a Windows-based program that provides a graphical user interface, drop-
down menus, toolbar buttons, and other features to perform the configuration of Datapanels. You
can use DataDesigner to configure multiple Datapanels of the same type. DataDesigner can be used
to configure the following Datapanel models:30/35, 40/45, 50/55, 60/65, 80/85, 150, 160, and
240E.

DataDesigner is used to build a project, which contains tag definitions, page layouts, messages and
function key definitions.  DataDesigner compresses the project into a single database, which is
transferred along with the communications protocol to the Datapanel via the PC download port.

This manual assumes a working knowledge of the Windows environment. For more information
about menus, toolbars, etc., consult your Windows documentation.

DataDesigner requires a PC-compatible computer running Windows 95/98/NT or Windows 2000.

2
Chapter
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Data Flow Between the Controller and the Datapanel
The Datapanel provides efficient communications with the controller to ensure prompt process
response to operator input and rapid update of Datapanel displays. This ensures that the operator is
always working with the most current information. The information on the protocol required by the
controller must be loaded into the Datapanel from DataDesigner. This is accomplished by choosing
the appropriate controller from a list.

Communication between the controller and the Datapanel is accomplished by configuring
controller addresses into tags and transmitting them over a serial link. The Datapanel automatically
generates the specific format or protocol required by the particular controller.

A diagram of the flow of data into and out of the Datapanel is shown in the following figure.
Although understanding the data flow between the controller and the Datapanel is helpful to the
configuration process, the DataDesigner user interface provides a simple method of proper
configuration. DataDesigner will assist you in making the correct selections.

Graphic Display

Touch Screen or
Keypad Entry

TAG
PROCESSING

(including
scaling

 if configured)

EXTERNAL
DEVICE
(PLC or

Controller)

Figure 2-1.  Simplified Data Flow Diagram
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Analog and Discrete Data
Continuously variable plant process data are considered analog variables. Such values may
represent temperatures, pressures, timers, counters, etc. Within the controller and Datapanel, these
variables are stored and processed as digital representations of the analog values.

Discrete variables can have a limited number of states, e.g., ON/OFF or OFF/LOW/
MEDIUM/HIGH. Data from a discrete variable is stored in the form of one or more bits values (1
or 0) which represents the states of a variable.

The Datapanel has provisions for storage and manipulation of both types of variables.
DataDesigner provides an easy method of defining data storage without needing detailed
knowledge about the internal structure of the Datapanel. Each analog or discrete variable is
identified by an alphanumeric tag. This tag capability allows you to assign meaningful, easily
remembered designations for the data. Limits can be associated with the tags to trigger alarms in
the case of out-of-tolerance data values.

Scaling of Raw Data
The raw data provided by the controller can be converted into engineering values according to the
information supplied during configuration. For example, a process input in the controller might
have a value between 25 and 255. The conversion information could be configured to scale the
value to between 0 and 100 degrees Celsius.
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Figure 2-2.  Scaling of Raw Data
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Configuration Procedure

The configuration of a Datapanel involves four main steps:

1. Creation of a database.

2. Definition of the tags indicating the points
to be monitored or controlled.

3. Configuration of the page displays.

4. Transferring (downloading) the database to the
Datapanel. Refer to Chapter 10, “Loading Your
Datapanel” for details on hardware setup and using the Transfer utility.

The execution of these four steps is outlined in chapters 4 through 10, which describe a typical
configuration operation. The examples given assume that you are either creating a new database or
modifying an existing database.

Note: Datapanel Models 30 and 35 are message centers only, and can only
display text information.  No function keys or edit keys are available
with these models.

Additional detailed information on some of the menus and choices is provided in Chapter 11,
“Advanced Configuration.” Advanced DataDesigner capabilities are also described in the detailed
information. Operations relating to transferring or uploading are described in Chapter 10, “Loading
Your Datapanel.

Watch for these two symbols to help guide you through the installation and operation:

Shows tips on performing operations.

Indicates where to find detailed information.
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Getting Started

This chapter provides details on how to install and start DataDesigner software. It also provides an
overview of the menu selections, main window toolbar, and status bar.

Installing DataDesigner Software
DataDesigner is designed to install and run under
Windows  95, Windows 98 , Windows NT 4.0, or
Windows 2000.

DataDesigner follows the typical Windows installation procedure:

1. Apply power to the computer. (It is not necessary to have the Datapanel connected or to
configure either the computer Comm port or the Datapanel Comm port.)

2. Start Windows NT, Windows 95, Windows 98, or Windows 2000.

3. Insert the DataDesigner floppy disk in the disk drive.

4. Start DataDesigner setup:

A. Click START, RUN.

B. Type the floppy disk drive letter + :SETUP, e.g., a:\setup. Press .

C. Follow the instructions on the screen..

The installation program will create the following directory and file structure:

3
Chapter



3-2 DataDesigner Software User's Guide – November 2001 GFK-1658B

3  

DataDesigner File Structure
DATADESIGNER (or the name chosen during installation)

BITMAPS (2-color bitmaps for use with monochrome displays)

CMD (all files containing Datapanel command software)

The files are named as follows:

Wxxxyzzz.cmd

W is e – engineering version
A – OEM special version
V – English version
F – French version
G – German version

Xxx is the software version 510 - matches DataDesigner version 5.1.0

Y is patch onto the main version

Zzz is the Datapanel type (30, 35, 40, 45, 50, 55, 60, 65, 85, 150, 160, or 240E)

DBASE (all files related to the Datapanel projects)

DP30 (sample database for Model 30 using the simulation protocol — Protocol #00)

|
|

DP160SNP (sample database for Model 160 using SNP/SNPX protocol — Protocol #68)

Note: The first databases are for particular panels and use the simulation
protocol (number 0) so that the features look like they have live data.
Databases that end in ‘SNP’ use SNP/SNPX protocol number 68. These
show an example of how to communicate with the series 90 PLC.

UserName-1 (location of database and name created by user)
|
|

UserName-n (location of database and name created by user)

.DB3 files (configuration files used by DataDesigner for UserName-n)

.DTB files (database for UserName-n compiled from .DB3 files by Transfer Utility.
Used by Datapanel only.)

HELP (DataDesigner help files)

PROTOCOL (all protocols available at the time of release of this version of DataDesigner)

STYLES (four black and white push button styles)

FONT (10 font styles)
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Starting DataDesigner Software
If a Start menu entry was created, select, Start, then select Programs, and DataDesigner. If no Start
menu entry was created:

•  Click START, RUN.

•  Type “c:\DataDesigner\DataDsgn”, press . (If DataDesigner is installed in some other
directory, use that path.)

DataDesigner Software Main Window

The main (opening) window of DataDesigner contains a menu bar, a toolbar across the top, and a
status bar along the bottom that provides information relating to the specific operation being
performed.

The main window title bar displays the name of the currently open project. The main window
toolbar has a number of shortcut buttons available for selected tasks. The functions of the buttons
are identified by tool tips associated with the button. Additional tasks can be found on the
DataDesigner menus. The window status bar provides helpful information as you work with
DataDesigner.

Project Name
Main Toolbar

Graphics Toolbar

Graphic Page:
size and shape
conforms to the
screen area of the
Datapanel

Configurable
Function Keys:
available only for
Datapanels that have
function keys.

Status Bar: description of toolbar button pointed to,
Datpanel type, memory used, and memory available

Figure 3-1.  DataDesigner Main Window
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Main Window Menu Bar
The main window menu bar offers nine selections:

File   Edit   View   Project   Datapanel   Layout   Graphics   Window   Help

File

Choosing File from the menu bar accesses a drop-down menu with eight selections:

New Project – allows you to create a new database.  After specifying the name and Datapanel type
for the database, DataDesigner will automatically open the Screen Editor dialog and the Protocol
Selection dialog.

Open – allows you to open a Database or a .DTB file.  Upon opening a database, DataDesigner
will automatically open the Screen Editor dialog box.

Close – Closes the current project.

Save – allows you to save the contents of the highlighted editing dialog box or window (graphic
page, tag, message table, overview group, comms block, or recipe).

Save Project As – allows you to save the current database into a new database of the same or
different type.

Save All – allows you to save the contents of all open editing dialogs.

Delete – Deletes the contents of the highlighted editing dialog box or window (graphic page, tag,
message table, overview group, comms block, or recipe).

Export – Exports the database to a tab-delimited ASCII file.

Import – Imports a tab-delimited ASCII file into the current database.

Print – Allows you to print a graphic page as graphics or text.

Printer Setup – standard Windows print utility. Allows you to select printer, layout, and printer
options.

Preferences -- allows the selection of Enable Automatic Bit to Tag for converted databases (pre
version 3.0.0).

Exit – Closes DataDesigner. If you have edited the current database, DataDesigner will prompt you
to save your changes.

Edit

The selections on the Edit menu allow you to perform operations on the graphic page. (Many of
these selections are also available on the right click popup menu.) Some selections are active only
when a graphic object or objects are selected.

Undo allows you to undo operations performed since the last save. Indicates the number of
operations you have performed on the current graphics page.

Cut removes the selected object or objects and places the selection on the clipboard.
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Copy copies the selected object or objects and places the selection on the clipboard.

Paste places DataDesigner objects that have been cut or copied onto the graphic page. (If you paste
onto the current page, the pasted object will appear on top of the original. If you paste onto a
different page, the objects will appear at the same coordinates as the original.)

Delete removes the selected object or objects.

Select all selects all objects on the current page.

View

New – Depending on the dialog box or window selected, creates a new graphic page, tag, message
table, communications block, overview group or recipe.

Previous – Shows the graphic page, tag, message table, communications block, overview group or
recipe previous to the one currently being viewed.

Next – Shows the graphic page, tag, message table, communications block, overview group or
recipe after the one currently being viewed.

Browser – Opens the browser for the editor currently in focus. The Graphics page, Comms Block,
Message Table, and Overview Group editors have browsers.

Main Toolbar – Hides or shows the main toolbar.

Graphics Toolbar – Hides or shows the graphics toolbar.

Project

Each of the following selections (except Communications Block and Message Browser) can also be
accessed by clicking on a toolbar button as shown in Figure 3-1.

Open Project – Opens a project.

Close Project – Closes the project.

Graphic Pages opens the Graphic window for designing graphic pages for display on the
Datapanel.

Protocol Type opens the Protocol and Port Settings dialog box so you can select the protocols for
Datapanel-to-controller communications.

Communications Blocks  – Opens the Communications Block Editor.

Tags  – Opens the Tag Editor.

Message Tables allows you to configure a message table. Message display is controlled by an
associated tag. Opens the Message Table Editor dialog box.

Recipe Groups allows you to configure a group of recipe tags to be displayed together.

Overview Group allows you to select a group of up to 10 tags to be displayed together. (A
database can have up to 100 overview groups.) Opens the Overview Group Editor.
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Datapanel

Clock Communications  – Allows you to configure the transfer of Real Time Clock data between
the Datapanel and the controller.

Page Change allows you to define two addresses in the controller – the address from which to read
the page control register and the address to which the current page number is written in the
Datapanel 30/35, 40/45, 50/55, 60/65 or 85.

System Settings allows you to configure the following Datapanel settings: Display, Status LED,
System flags, and Arrow Keys.

System Keys allows you to configure operations for the Datapanel’s embedded function keys.

Passwords allows you to specify password protection for Off-line, Graphic Page Drive Out, and
Overview Drive Out.

Comm Port 1 – allows you to configure settings for comm port 1.

Comm Port 2 – allows you to configure settings for comm port 2.

For details, see Configuring Datapanel Communications.

Note: These port settings apply to Datapanel-controller communication, not
Datapanel-PC communication. The port settings configured by this
selection in DataDesigner are activated by the Datapanel when the
Datapanel is connected to the controller.

Transfer -- starts the Datapanel Transfer Utility, which implements the transfer of configuration
information from DataDesigner to the Datapanel.

Layout

Group -- groups selected objects so that they can be displayed in the Datapanel as a single unit. To
select multiple objects, click and drag to draw a box around them or hold down the shift key while
clicking the objects you want to select.

Ungroup -- ungroups the selected group of objects.

Align to -- allows you to select left, right, top, bottom, horizontal center, and vertical center
alignment for selected objects.

Z order –  provides the ability to rearrange the stacking order of graphics. When this item is
selected, a drop-down list will appear with three selections:

Edit Z order allows you to arrange the stacking order without limitation. When this item is
selected, the Overlaying Order dialog box will appear.

Shuffle overlaid causes the stacking order of overlaid items to be changed by bringing the
graphic on the bottom up to the top.

Send to back causes the selected graphic(s) to be moved behind all other graphics.

Template allows you to add or delete a template on the page. Selecting Add opens the Graphic
Browser dialog box.
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Embed Comm Blocks – Embeds configured communications blocks into the current graphic page.

Graphics Grid – configures the snap-to-grid feature of DataDesigner.

Set Grid  – allows you to configure the grid spacing and the intervals of lines displayed. Opens
the Set Graphics Grid dialog box.

Grid On/Off  – When Grid is on, graphic objects will automatically be aligned to a grid node
when you create or move them.

Hide/show graphics grid lines -- Available if Graphics Grid On is selected. Show Grid Lines in
the Set Graphics Grid dialog box has a similar function. Turns the display of grid lines on and
off.

Touch Grid On/Off – Toggles the display of the touch region grid for Datapanels that have touch
screens.

Animation On – Displays the graphic pages in animation mode.

Zoom In – Enlarges the graphic page display.

Zoom Out – Makes the graphic page display smaller.

Graphics

Text – Creates a formatted text object.

Tag Display – Displays tag data. You can select the tag attribute, such as Value, Name, Alarm, etc.
to be displayed. Available tag attributes are determined by the tag type.

Message – Displays a message table which contains text messages associated with tag values.

Choose Font – Allows you to choose the font for a text, message, or tag display.

Lines/Shape – Creates lines or a filled polygon.

Frame – Creates a frame.

Circle – Creates a circle.

Rectangle – Creates a rectangle.

Bitmap – Allows you to select a bitmap to be displayed. Bitmap display can be associated with tag
attributes.

Trend – Creates a simple trend display.

Trend Recorder – Creates a more elaborate trend display.

Meter – Creates a bar chart display.

Touch Region – Configures touch region operation for Datapanels that have touch screens.

Push Button – Configures Push Button operation for Datapanels that have touch screens.

Drive Out – Allows you to designate a tag as a Drive Out point. This allows the operator to
transmit new values for the point to the controller in the Run Mode.

Select Graphics – Default editing mode. Allows you to select graphic elements with the mouse.
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Window

Selecting Window from the menu bar accesses a drop-down menu with four selections that operate
in the usual Windows manner.

Help

Selecting Help from the menu bar accesses the built-in DataDesigner help function. The help
function operates in the usual Windows manner.
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Setting up the Datapanel Database

This chapter presents a typical procedure for creation of a Datapanel database. For each Datapanel
model, DataDesigner provides a sample database that can be used as an example. See
“DataDesigner File Structure” in Chapter 3.

Creating a Database
There are a number of possible sources of databases:

•  If no suitable database exists, you can select New from the File menu to create a new one and
configure it for the current application.

•  If a suitable database has already been created by DataDesigner, you can Open it in
DataDesigner, modify it if necessary, and download it to the Datapanel. The database will exist
as a complete set of .DB3 files in the particular database’s folder (some used by DataDesigner
and one file downloaded to the panel, which is a .DTB file that is in a format the panel can
understand).

•  If you are modifying a database that already exists in the Datapanel, you can Upload the
database to DataDesigner, modify it, and download it back to the Datapanel.

•  If a suitable database is available from another source, you can Import the database into
DataDesigner.

The options for creating databases are listed in Table 4-1. The New Project, Open, and Import
commands are accessed from the File menu. Transfer is accessed from the Datapanel menu.
Choosing one of these options will produce one of the dialog boxes listed in “Database Creation
Procedure.” There is an icon for Transfer on the toolbar.

Note: To delete a database, use Windows Explorer to delete the folder from
the DataDesigner DBASE folder. (You cannot delete the current
database shown in DataDesigner.)

Table 4-1.  Database Creation Options

 What would you like to do? File Menu Dialog Box

 Create new project New New Project

 Open existing project Open Open Project

 Open .DTB file Open Open .DTB File

 Get database from Datapanel Datapanel Transfer Utility

 Import a database Import Database Import

4
Chapter
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New Project Dialog Box

To open a new database, select New
from the File menu.  Select the
appropriate Datapanel model/database
type from the pull-down list.  In the
dialog box, type the name of the
database in the Project Name text box.
Click OK.

Database Type
Displays the various Datapanel types from which you can choose to associate your database.
Select the appropriate Datapanel model/database type from the pull-down list.

Project Name
Allows entry of a name for the new database.  Enter the name, then click OK.

Note: Database names can be up to eight characters long. Alphanumeric
characters (A—Z and 1—9), as well as the underscore (_) character are
allowed.

Version
Displays the version of the active database. Starts at 1.0 when you create a new database and
increments by .01 when you edit and save the database.
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Open Project Dialog Box

Project Name
Displays the name of the currently active
database.

To open an existing database, click the
arrow in the Project Name text box to
access the drop-down list of available
databases. The list will show those
databases that are in the Dbase
subdirectory of the directory containing
DataDesigner. Choose the desired
database, click OK.

Database Type
Displays the Datapanel type associated with the currently selected database.

Version
Displays the version of the active database. Starts at 1.0 when you create a new database and
increments by .01 when you edit and save the database.
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Open .DTB File Dialog Box

Source Name and Location

 To open a .DTB file, click the path button next to the Source Name and Location box. The
Select Source Database browser window will open. Navigate to the folder containing the DTB file
you want to open and click the file name.

Destination
In the Name box, you can either type the name of a new database to be created, or select an existing
database from the dropdown list. If you type a new database name, the message “Database does not
exist. Create?” will appear. To create the new database, click yes. If you select an existing database,
DataDesigner will replace it with the contents of the selected .DTB file.

If the source folder containing the .DTB file is the same as that specified for the destination,
subsequent modifications to the database will overwrite the original .DTB file when you do a
transfer to the Datapanel.
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Transferring a Database from the Datapanel
Note: For transfers to occur, DataDesigner must be connected to the Datapanel

using the download cable, and the Datapanel must be in Host Transfer
mode. Refer to the Datapanel manual for details on how to put the
Datapanel in this mode.

To transfer (upload) a database from the Datapanel:

1. Click the Transfer Utilities button , or select Transfer from the Datapanel menu. The
Datapanel Transfer Utility dialog box  appears.

1. In the Datapanel Transfer Utilities dialog box, click the Upload Database box.

2. Click Database under “Set File Locations”. This brings up the Select Database File dialog box.
Navigate to where you want the .dtb file to be stored on your hard drive.

3. Click Start Transfer. This takes the image of the database in the Datapanel and saves it as the
file you specified in the database box.

4. When the transfer is complete, click Exit
Program.

5. To uncompress the .dtb file into the .db3
files that DataDesigner uses, select Open,
.DTB File from the File menu. The Open
.DTB file dialog box appears.
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6. To locate the .DTB file that you just uploaded, click the browse button next to the Source
Name and Location box. The Select Source Database browser will open. Select the new .DTB
file and click OK to return to the Open .DTB file dialog box.

7. Enter a Destination Name for the database. (You can either overwrite an existing database or
create a new one.) If you specify a new database name, DataDesigner will create a new folder
for it.

8. Click OK.

For more information about using the Transfer Utility, refer to Chapter 10.

Placing Datapanels in Host Transfer Mode

Datapanels may be placed in Host Transfer Mode in two ways. The first method is to press the
Mode Key (F5) while the Datapanel is on-line (displaying user configured screens). The Offline
key (F6) is then pressed followed by the Transfer key (F5). The second method may be used with
version 5.1 and later Datapanels. Using this method, start the Goto Transfer command in the
Transfer utility (Special menu), then power cycle the panel. The panel will come up in Host
Transfer mode.

For earlier Datapanel versions, refer to the user's manual for your Datapanel for information on
going to Host Transfer mode.
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Importing a Database
DataDesigner provides the ability to import components of database configuration in a tab-
delimited form. For large applications you can use a spreadsheet to create the configuration, then
generate a tab-delimited file to be imported into DataDesigner.

The tab-delimited files contain a specific text format that represents the configured components of
the DataDesigner database. This is useful for large applications that might use a spreadsheet for
configuration before generating a tab-delimited file and importing it into DataDesigner. Import
supports the following database records (you can import anything you can export):

•  Analog Tags

•  Digital Tags

•  Comms blocks

•  Message tables

•  Overview groups

Each record type has its own tab-delimited format. The formats match the output generated by the
Export function provided by DataDesigner. It is recommended that, before you begin construction
of a new database from a spreadsheet, you first export a simple database from DataDesigner and
look at it in the spreadsheet software to get an understanding of how the information in the cells is
formatted. DataDesigner exports databases to a tab-delimited file with an extension of .rpt.

To import a database:

1. Select Import from the File menu. The Database Import dialog box will appear.

2. Click the file directory icon next to the File Name field to display the Open dialog box.  Locate
the desired file (with an extension of .rpt) and click Open.
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The selected file name will appear in the File Name field.

Under Import Options, select the components you wish to import.

Click Import to initiate the import operation. The Progress Message box will display information
pertaining to the operation as it takes place.
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Configuring Database Parameters
Active choices depend on the Datapanel model being configured. Some of the menu choices relate
to general database items and some relate to the configuration of displays. The general database
items are discussed first.

Protocol Type

Datapanels are designed to interface with PLCs or other controllers for which Datapanel
Communications Protocols exist. You will need to select the correct protocol from the list of those
supported to ensure that the correct parameters are used when accessing data from the controller.

Datapanels that have two ports can have two, possibly different, protocols loaded into the panel.
This feature allows two PLCs to be connected to the Datapanel.

 Select Protocol Type from the Project menu or click the toolbar Protocol button to access the
Protocol and Port Settings dialog box.

Under Sort Protocols By, click Number or Name according to whether you want the list displayed
numerically or alphabetically by name.

For each channel, select a protocol and a communications port from the drop-down list.

Note: To make the help available for the selected protocol, click the Apply
button.

Note that the Advanced buttons are active in the Protocol and Port Settings dialog box only when
one of the following protocols is selected. They are used to configure additional parameters for
these protocols.
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•  Protocol 91 — Genius (Datapanel 160 or 240E model)

•  Protocol 68 — SNP/SNPX

•  Protocol 80 — Modicon Host slave

The following restrictions apply to protocols:

•  Certain protocols (#25, #141, & #92) can't be loaded twice and can only be used on COM1.

•  The multiport panels (160, 240E) will use whichever serial port is free (if any) for printing.

•  If a protocol is configured for both COM1 and COM2, serial printing is disabled. If COM2 is
used, serial printing will occur on COM1. If only COM1 is used, serial printing occurs as
normal on COM2.

When certain protocols are selected, DataDesigner displays a Modify Comm Settings dialog box
that presents a standard communications port setting appropriate for that selection. To accept these
settings, click Yes. To ignore the suggestion, click No.

Advanced Protocol Settings

Advanced Settings for Genius Protocol

Advanced choices for Protocol 91 (Genius) are available for the DP160 and DP240E models.

Note: These settings are only to be used as a reference for setting the
appropriate switches on the PC104 card.  The switch settings on the
PC104 card are not overwritten by this dialog box and will still need to
be set appropriately.  Please refer to the PC104 Genius Installation
Guide for assistance in setting these switches.
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PCIM Configuration Advanced Choices Dialog Box

Shared RAM Address
Displays the required setting on the PC-104 card. This is not editable. For information about setting
this address on the card, refer to the PCIM documentation.

IO Port Address
Displays the required setting on the PC-104 card. This is not editable. For information about setting
this address on the card, refer to the PCIM documentation.

Global Data Address
The Global Data Address is the beginning address of the Global Data where a receiving Series Six
will place the data. A Series 90-70 or Series 90-30 PLC does not use this reference. This is entered
in hexadecimal.

Global Data Length
The Global Data Length is the number of bytes that the Datapanel will output to the controller as
global data. It is entered in decimal. Consult the protocol 91 documentation in the Protocol.hlp file
for how to write data through this method.

Default Values
To reset the values in all fields to DataDesigner default values, click this button. These defaults will
send no global data from the Datapanel.

Advanced Settings for SNP/SNPX Protocol

If the protocol selected is 68 (SNP/SNP-X), an Advanced button appears in the Communications
Protocol dialog box.
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Protocol 68 Advanced Choices Dialog Box

This dialog box supports fault screens that allow the operator to view Series 90 PLC and I/O Faults
and the run state of the processor. The options in this dialog box are only used with the built-in
fault screen featured in certain Datapanel models when the SNP protocol is selected.

PLC Configuration

Single Node
If single node is selected, the SNP ID boxes are grayed out and a wildcard is used to determine the
SNP ID at runtime.

Multidrop
If a channel of the Datapanel is connected to a multi-drop network, the SNP IDs of the processors
that you want to interrogate with the fault screens must be provided in the Node Identification box.

PLC Access Permission

Read Only
If Read Only is selected, PLC operations will be disabled on the Datapanel.
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Read/Write
If Read/Write is selected in the database, the operator will be able to clear the fault tables and
change the run mode of the processor.  If a Level 2 Password is configured on the processor, the
operator will be prompted to enter it before these actions can take place.

Node Identification
For multidrop configurations, this box lists nodes that have been identified. To remove a node from
the list, select it and click the Remove button. To add a node, type the node name in the Enter Node
Name box and click the Add button. Up to 32 SNP IDs may be entered.

Enter Node Name
To add a node name to the Node Identification box, type the new name here and click the Add
button.

Advanced Settings for Modicon Host Slave

If the protocol selected is 80 (Modicon Host Slave), an ‘Advanced’ button will appear for that
channel in the Communications Protocol dialog box.

Advanced HostComms Configuration Dialog Box

Node ID
Identifies the Datapanel’s node ID on the MODBUS network.
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Print Options

Print options can be selected, in the Protocol and Port Settings dialog box for Datapanel models
160 and 240E. These panels will use whichever serial port is free (if any) for printing. If an option
is selected, messages, including time and date will be printed as the event occurs.

•  System Start-up Message – System powerup or transition into run mode
•  Tag Alarms – Tag alarm occurs or is acknowledged
•  Events – Change of state for a special type of digital tag alarm
•  Operator Writes – Operator presses a key or touch region to initiate Write (driveout) function
•  Comms Errors – Communications error occurs
•  Text Pages – Screen dump function key pressed or Display Page and Print comms block

generated

- Only text-type objects are printed from the panel : text, message tables and tag displays.
Tag displays can be the value, name or other tag attribute.

- Shapes, lines, bitmaps, trends, bar charts and meters are not printed.

- Dynamic Attributes: Only Show/Hide is supported during printing for associated objects.
Thus if a tag value display is configured for Show/Hide and the value is currently hidden
on the screen, the value won’t be printed.

Page Change (Models 30/35, 40/45, 50/55, 60/65, and 85)
When the Page Change option is selected from
the Datapanel menu, the Page Control dialog box
is displayed.  The Read channel is used to get a
page number from the controller; the Datapanel
then switches to that page. The Write channel is
used to send the current page number to the
controller.

When a channel is selected, a communications
parameters grid appears. The protocol you have
configured for the selected channel determines
the set of parameters you see in this area of the
dialog box. For details on these parameters, refer
to the online help for the protocol you are using.

The Page Change option is only available for the
30/35/40/45/50/55/60/65/85 panels.



GFK-1658B Chapter 4  Setting up the Datapanel Database 4-15

4 

Configuring System Settings
System settings control the operating characteristics of the target Datapanel. These characteristics
include Display characteristics, Status LED operation, Alarms, and Page Changes. Arrow key
operation can be configured for models 150, 160, and 240E.

Select System Settings from the Datapanel menu or click on the System Settings button to
access the System Settings dialog box. The dialog box has three tabs:

•  Settings

•  Status LED

•  Passwords

The configuration will become active when the database is downloaded to the Datapanel.

System Settings Dialog Box

The appearance of this dialog box
depends on the Datapanel type
selected for the current database.
You may not see all of the
parameters listed below. The
system settings selected will
become active when the database is
downloaded to the Datapanel.

Settings Tab

Note: The following parameters do not all apply to every Datapanel. For more
information, please refer to the user’s manual for the specific Datapanel
model.

Display

Contrast
To set the contrast of the LCD display, select a value in the Contrast box.
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Backlight
Click the Backlight checkbox to enable use of the backlight. If this box is checked, Timeout can be
configured. (Does not apply to Datapanel 240E.)

Timeout
Sets the time (minutes) the backlight remains on if the Datapanel is inactive. If this value is set to 0,
the backlight will stay on constantly. If the Datapanel remains inactive for a period exceeding the
Timeout configuration time, the backlight will go off. The light can be re-activated by pressing any
key on the keypad.

Note: For 240E, this value can be 0 or 60. If it is set to 0, the backlight will
stay on constantly.

System

The System section sets the Datapanel characteristics that the operator will see (see “Operator
Customization”).

Alarms
Click the Alarms checkbox if you want alarms enabled.

Page Change
Click the checkbox if you want the operator to be able to access to different pages by using the up
and down arrow keys or by using page number + . If Page Change is not selected, embedded
function keys, touch regions, and Page Change comms blocks become the only means of
navigation on the system.

Return To Last Page
Click this checkbox if you want the Datapanel display to return to the last-used page after viewing
an alternative display, such as an overview page.

Startup Page
Enter a number here if you want a specific page displayed when the Datapanel is started up or
when returning from off-line. If no startup page is specified (default = 0), the Datapanel logo page
is displayed on the DP150/160/240E at startup or when going on-line.

Node ID
A Node ID is required if the Datapanel is operating on a network with more than one PLC and one
Datapanel. The Node ID is a unique network identifier for the Datapanel. The Node ID may be
omitted if not required.
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Latch Alarm Log Values
When an alarm is generated, the actual alarm value will be retained in the log instead of being
updated.

Ignore Function Keys
Clicking this box disables programmed function keys during operator write.

Arrow Keys

This section is present in the dialog
box only for Datapanel models 150,
160, and 240E. For these models, the
arrow keys can be configured to
perform certain operations in the
same manner that Function keys can.
When this section is initially
presented, the labels for both the up
arrow and the down arrow will be
“Default.” If the arrow keys are not
configured, they perform their
normal functions (page change).
When the arrow keys have been
configured, the label will read
“Configured.” Clicking on the Up
arrow or the Down arrow opens the
UpArrow Key dialog box or the DownArrow dialog box as appropriate.

Available types of operator inputs consist of Write, Ramp, Jog, Toggle, Goto, Recipe
Load/Transfer, and Macro. For more information about these operations, see “Configuring Output
Operations”.
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Status LED Tab

Status LED

This tab appears only for Datapanels that
have status LEDs.

Key Press
The LED blinks and the Datapanel
annunciator beeps each time a key is
pressed.

User Status
Allows the status LEDs to be configured
to produce a visible warning that some
condition or event has occurred in the
controller.

The appearance of this table depends on
the type of Datapanel being configured. For Datapanels that have a single status LED, the LED can
be set to operate steady, slow, and fast flash based on a selectable attribute of a tag.

For Datapanels that have LEDs associated with function keys, each LED can be configured to light
based on the value of a tag.
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Passwords Tab

Certain Datapanel options can be
password-protected to prevent
unauthorized operation or changes. If
you do not enter password data, these
areas will be unprotected. The options
that can be protected are:

•  Off-line
•  Graphic Page Drive Out
•  Overview Drive Out

Enter a password for each area you
wish to protect. The password must be
numeric and must be no more than six
numbers long. Add the passwords to
the database by pressing  or
clicking OK.

Note: It is important to keep a copy of the database on floppy or hard disk so
that, if the passwords are forgotten, the database can be loaded into
DataDesigner and the passwords read from the System Passwords dialog
box.
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Setting Database Preferences
To set automatic features for database editing,
go to the File menu and select Preferences.
The Preferences dialog box will appear.

Enable automatic bit to tag
This option pertains to the obsolete Register and Bit tag types that were used in an older version of
the predecessor to DataDesigner.

If this option is selected, when you open a graphics page, DataDesigner will search for Register and
Bits tags on that page and give you the option of converting all of them.

If this option is not selected and you attempt to edit an object containing a Bit or Register tag,
DataDesigner will give you the option of converting the selected item to an Analog or Digital tag.
If this option is not selected, the only way locate Bit and Register tags is to attempt to edit all the
objects on each page.

Operator Customization
After configuration, the settings for LCD Contrast can be changed at the Datapanel by the operator
to suit individual preferences. Changes made to the settings in this way are saved in memory and
become the new default settings at start-up, overriding the values stored in the database when
configured by DataDesigner. The original configured values will be restored if the database is
downloaded from DataDesigner.

More Information
Analog and Digital Tags See “Configuring Analog Tags” in Chapter 5.

Page See “Initial Page Design,” Chapter 6.

Function Keys See “Configuring Operator Input,” Chapter 8.
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Configuring Tags, Groups, and Message Tables

This chapter describes how to configure analog and digital tags, recipe groups, and message tables.

Tags are the Datapanel specification of controller data to be accessed and processed by the
Datapanel. The tag includes information on the controller address of the data, nature of the data
(analog or digital), scaling requirements, and alarm limits. Tags are identified by a user-defined
alphanumeric name. Meaningful tag names aid the user in configuring the database and the
operator in using the Datapanel for process control.

Overview groups can be used to display selected tags together. Up to 100 groups can be configured,
each containing a maximum of 10 tags (5 tags maximum for models 150 and 160). The tags
selected for inclusion in a group can be either analog or digital or a mixture of both. The operator
can access these groups by using the function keys or touch regions on the Datapanel and selecting
the Overview page.

Recipe groups provide a means of defining blocks of data values to be sent to defined address
blocks in a target device.

The normal Windows cut/copy/paste functions can be used on many fields, tags, etc.

Configuring Tags
 Click the DataDesigner main toolbar Tags button (not the Graphics toolbar button) to access

the Tag Editor, which is used to configure data type, format based on controller protocol, input and
output channels, properties, and alarms.

You can configure the following types of tags:

Analog
Unsigned Word, Signed Word, Unsigned Dword, Signed Dword, Floating Point, and Text. Any of
these except for Floating Point tags can be configured as Recipe Tags.

Digital
Single Bit, Double Bit. Any of these can be configured as Recipe Tags.

5
Chapter
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Tag Editor Dialog Box

The Tag Editor allows you to assign tags to controller data that will be monitored and controlled by
the Datapanel application.

Input Tab

Tag Name
To create a new tag, enter a descriptive alphanumeric name in the Tag field. The name is limited to
a maximum of 32 characters. To edit an existing tag, select the tag name from the drop-down list.

If a tag is selected:

 To create a new tag, click the New Tag button on the toolbar. (The function of this button
changes, depending on which editor or window is currently selected.)

 To delete the currently selected tag, click the Delete Tag button on the toolbar. (The function
of this button changes, depending on which editor or window is currently selected.)
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Data Type
Select a data type from the drop-down list of data types.

Type Range

Unsigned Word 0 to 65,535

Signed Word -32,768 to +32,767

Unsigned Dword 0 to 4,294,967,295

Signed Dword -2,147,483,648 to +2,147,483,647

Floating point 3.4 x 10-38 to 3.4 x 10+38

Text Max. number of characters for analog tag = 32.  (Actual number of viewable
characters is specified length – 1.)

Single Bit 0 to 1

Double Bit 0 to 3

Communications Parameters Grid
The protocol you have configured for the selected channel determines the set of parameters you see
in this area of the dialog box. For details on these parameters, refer to the online help for the
protocol you are using. (Click the information button for the appropriate protocol from the buttons
above.)

If the channel selection is Internal, select a register or bit. In this case information is read from the
Datapanel’s internal bit or register tables and not from an external controller.

Recipe Tag
To configure this tag as a recipe tag, which can be used in recipe groups, select this box. (For
recipe tags, an Output Channel must be configured. The Input Channel is disabled.)

Channel
Specifies which channel the remote address is connected to (A or B). The letters A and B refer to
the settings made in the Protocol and Port Settings dialog box and are not COM1 and COM2 (you
can reverse them so that A is COM2 and B is a PC-104 card for example).

Text Length
(Required for Text data type) When Text is chosen as the data type, the Length field is activated.
The length is the number of characters that are reserved in the PLC. It should be the number of
characters in the largest string plus one for a NULL terminator. (The length of the text to be
displayed can be controlled by the width box on the graphics page.)
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Output Tab

Channel
Specifies which channel the remote address is connected to (A, B, Internal, None). The letters A
and B refer to the settings made in the Protocol and Port Settings dialog box and are not COM1 and
COM2 (you can reverse them so that A is COM2 and B is a PC-104 card for example).

Read after Write
Click the Read after Write checkbox if you want a confirming read of the data after writing new
values to the controller.

Communications Parameters Grid
Contains a PLC address for writing that defaults to the same address as that specified in the Input
Tab when first configured.  The protocol you have configured for the selected channel determines
the set of parameters you see in this area of the dialog box. For details on these parameters, refer to
the online help for the protocol you are using. (Click the information button for the appropriate
protocol from the buttons above.)

If the channel selection is Internal, select a register or bit. In this case information is written to the
Datapanel’s internal bit or register tables and not from an external controller.

Note: Output for bit-type tags is restricted to a single bit. If the output is being
enabled for a double bit tag, only a single bit is shown.

Properties Tab

The appearance of this tab is determined by the Data Type selected on the Input tab. No properties
can be configured for a Recipe tag.

Refresh Field
Click the arrow on the Refresh field to access a drop-down list of available data display control
choices:

•  If Displayed - Data is collected from the controller only while the configured tag is being
viewed on a screen by the operator.

•  Page Change - Data is collected each time an operator displays a screen showing the tag. The
data will not be collected again until the same screen is re-displayed or a new screen with the
same tag is displayed.

•  Continuously - Data is collected at the frequency specified, regardless of the current display.

Frequency Field
Click the arrow on the Frequency field to access a drop-down list of available rates of data refresh
subject to the control choice made in the Refresh field. The available choices are: Inactive, .1, .2,
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.3, .4, .5, .6, .7, .8, .9, 1, 2, 5, 10, 30, 60 (seconds). Select by clicking on the desired frequency. The
default value is 1 second. A value must be specified for the tag to work.

The frequency box is unavailable if the input address is an internal Datapanel address. Internal tags
are accessed as fast as possible.

Note: For Datapanel models 40, 45, 60, 65, 80 and 85, the Refresh and
Frequency fields are not used. Tags for these models are always
refreshed only if displayed and as fast as possible.

Units
(Optional) Enter an alphanumeric name in the Units field for the data units to be used when
displaying the engineering units of the data (e.g., psi, Ft., Gal., Boxes). The name is limited to a
maximum of ten characters.

Decimal Places
(Optional) Enter the number of data decimal places in the Decimal Places field. This determines
how the data is displayed. If the controller raw data is 12345 and the Decimal Places field is set to
three, the data will be displayed as 12.345. If the field is set to zero, the data will be displayed as
12345.

Scale To Limits
This section determines how the raw controller (external) data will be stored in the Datapanel
(internal). This provides for scaling external data to engineering units. Click the Scale To Limits
checkbox if you want scaling of this data. If the box is not checked, no scaling will be performed
and the value of the Datapanel data will be the same as the controller value. If you clicked the
check box, enter the appropriate upper and lower limits of the external data, and the corresponding
upper and lower values in engineering units.

If the internal and external limits are the same and scaling is enabled, the Datapanel will not allow
the operator to enter a value that is outside of this range. The configuration can use this feature to
provide limit checking rather than/or in addition to scaling. For example, if you want to limit an
analog value to between 0 and 100, you can set internal and external values at 0 to 100 and the
operator will not be allowed to enter values outside this range.

External limits are the limits of the possible range for the variable in the controller. Internal limits
define the range to which you want to scale the external value. The value collected from the
controller will be scaled linearly before it is used for any display. Examples of limits and scaled
values are shown in the following table.

Table 5-1.  Example of Limits and Scaling

Limits Sample Values

Lower Upper 1 2 3

External 100 600 External (measured) 100 350 500

Internal 0 100 Internal (displayed) 0 50 80
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Alarm Tab
The type of tag being configured determines the appearance of this tab.

Analog Tags

Alarm Type

Select the type of alarm for the tag being configured. Choices are: None, High/Low, High, Low,
High/High, Low/Low, and Set No Display. This parameter determines the limits that you will be
able to set.

All alarm types except for the 'Set no Display' type trigger the Global alarm bit and also set an
alarm display in the Alarm Log page of your Datapanel.

Upper Limit

Sets the high tag value at which an alarm will be generated.

Lower Limit

Sets the low tag value at which an alarm will be generated.

Print Alarm

If you want alarms to be output to the printer as they occur, click this button. Printing of alarms
may be overridden globally using the Alarm Print Option (see Print Options).

Digital Tags

Status Text

Single Bit tags have two states that can be configured; Double Bit tags have four.

Each state can have a descriptive Status Text label associated with it, (for example, FAULT,
OPEN, CLOSED or INTRANS). Enter a maximum of 32 alphanumeric characters in each desired
label. Click the appropriate Alarm checkboxes to enable the alarms for the desired states.

Alarm

An tag state may be designated as an alarm state. Click the Alarm checkbox next to the desired
state.

All alarms trigger the Global alarm bit and also set an alarm display in the Alarm Log page of your
Datapanel.

Print Alarm

If you want alarms to be output to the printer as they occur, click this button. Printing of alarms
may be overridden globally using the Alarm Print Option (see Print Options).

Event

To print a message whenever the tag changes state, click the Event button. Event changes are not
displayed in the Alarm Log.
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Configuring Overview Groups
Click the Overview Groups
Menu item from the Project
Menu to access the Overview
Group Editor.

Overview Group Editor Dialog Box

An overview group can be
used to display selected tags
together. Up to 100 groups
can be configured, each
containing a maximum of 10
tags. The tags selected for
inclusion in a group can be either analog or digital or a mixture of both. The operator can access
these groups by using the function keys or touch regions on the Datapanel and selecting the
Overview page.

 To define tags, choose Tags from the Project menu, or click the Tag button on the main
toolbar.

 To create a new overview group, click the New Overview Group button on the main toolbar.
(The function of this button changes, depending on which editor or window is currently selected.)

 To delete the currently selected overview group, click the Delete Overview Group button on
the main toolbar. (The function of this button changes, depending on which editor or window is
currently selected.)

 To view the overview groups in sequence, click the Previous or Next Overview Group
button on the main toolbar.

Group Number
Indicates the group you are currently viewing. If a project contains only one overview group, this
field will be blank.

Group Name
Enter an identifying name in the Group Name field. A maximum of 19 alphanumeric characters is
permitted.

Tag List
Use these fields to select up to 10 tags to be included in the overview group. To select a tag, click
the arrow next to the field. To remove a tag, click the Clear button next to the field.
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Configuring Recipe Groups
Recipe groups provide a means of defining blocks of data addresses in a target device and blocks of
data values to be sent to that device. Special tags called Recipe tags are used to define the addresses
in the target device. Selected Recipe tags are combined together into a Recipe Group. The list of
tags in a Recipe group represents some logical association specific to the application such as flour,
sugar, water etc for a recipe group representing a bakery process.

Recipe tags have no input or read address, only an output or write address.  Three write operations
may be configured for tags in a recipe group. Load, used to set the tags in the group to an initial
value; Transfer to transmit the tags in the group to the controller and then Load/Transfer together as
a single operation. A button, touch area, or function key can be configured for any of the three
operations.

To create a recipe group, select Recipe Groups from the Project menu. The Recipe Group Editor
dialog box will appear.

Configure Recipe Groups Dialog Box

Configured Recipe Tags
Lists all configured analog and digital recipe tags.

Recipe Name
To configure a new recipe group, type an alphanumeric name in this box. To edit an existing group,
select the name from the drop-down list.
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Tags in Recipe
Displays the contents of the Recipe Group. To add a tag, select it in the Configured Tags list and
click the right arrow button. To remove a tag from the recipe, select it in this list and click the left
arrow button. To delete the Recipe Group, click the Delete button. To create a new Recipe Group,
click the New button.

When you have finished editing the Recipe Group, click the Close button.

Configuring Message Tables
Message Tables store multiple text strings for display according to the value of a tag. Maintaining
the messages in a library reduces the database space requirements and speeds the configuration
process. The library allows you to create a number of tables for convenient grouping of related
messages. A different table must be assigned to each group of values and texts. The same table can
be used on multiple pages and with multiple tags. When the message table is configured on the
page, the appropriate message will appear on the Datapanel depending on the value of the tag. A
hypothetical message table for an analog representation of temperature is shown below.

To create or edit a message table, select Message Tables from the Project menu.

Sample Message Table

Tag Value Message

0 Warning - critically low

10 Caution - excessively low

20 Low

30 Normal

40 High

50 Caution - excessively high

60 Warning - critically high

70 Danger - shut down process
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Edit Message Table Dialog Box

Use this dialog box to create or edit a message table. The messages making up the message table
are associated with a tag value. (The tag that controls the display of the messages is specified in the
Message Display dialog box.)

 To create a new message table, click the New Message Table button on the toolbar. (The
function of this button changes, depending on which editor or window is currently selected.)

 To delete the currently selected message table, click the Delete Message Table button on the
toolbar. (The function of this button changes, depending on which editor or window is currently
selected.)

 To select from a list of all the configured message tables in the project, click the Browser
button.

To build the message table
•  Select a Data Type and number of Decimal Places for the tag values.
•  Click the New Entry button. The first available line in the message table will be selected.
•  Type a tag value in the Value column, press Tab, and type the corresponding message text or

select an existing message from the drop-down list in the Text box.

Note: DataDesigner and Datapanel work similarly in that messages longer
than 40 characters are not completely displayed. If the line is contains a
carriage return, the message is displayed on two lines by both Datapanel
and DataDesigner. If a carriage return appears after 40 characters, only
those characters after the carriage return are shown on the second line.

•  Type a name for the table in the Table Name box. The table name can consist of up to 24
characters, including spaces.

•  Click OK to close this dialog box.

 To configure a message table display, click the Message button on the toolbar, or choose
Message from the Graphics menu. The Message Display dialog box will appear.
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Creating a New Message

To create a new message:

•  Open the Edit Message Table dialog box if it is not already open

•  Click New Entry.

•  Click the down-arrow on the right of the TYPE field to access a drop-down list of data
types. Click the desired type.

•  Analog. In the Value field, enter the tag value associated with the message. In the Text
field, enter the message as it is to appear on the page. The message can be more than one
line. Use the ENTER key to create a new line. Click on the up-down arrows on the right of
the Decimal Places field to obtain the desired number of places.

•  Digital. You can enter a separate message for each of the four possible digital values.

•  Message text added to a table is added to the message library for use in other tables. Select
existing messages from the MESSAGE TEXT drop down list.

•  Click OK to exit.
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Initial Page Design

This chapter, along with chapters 7and 8, presents a typical procedure for configuration of graphic
pages using the tags defined for analog and digital data. The Datapanel has a comprehensive
display capability that is easily implemented through DataDesigner software. A Datapanel can have
up to 100 graphic pages (up to 200 pages for models 3x/4x/5x/6x/85). Pages can display scaled
data, analog and digital tags, static text, dynamic text, touch regions, trend charts, bar graphs, and
embedded function keys. Many of the displayed items can be made dynamic, i.e., their appearance
is modified by the value of an associated tag. The pages are configured in DataDesigner and
displayed when the Datapanel is operated in the Run Mode.

See Chapter 11 for a discussion of advanced capabilities and how to use them.

6
Chapter
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Graphics Page Design Window
The Graphic design window is displayed by default when you open a project. (If it is not
visible, click the Graphic Pages button.) This is where you design the pages to be displayed

on the Datapanel.

The Page field displays the identification number of the displayed page. The Cursor fields show the
present position of the cursor. The Object fields show the present position of the lower left corner
of the selected object, or width and height if an object resizing handle is selected, in pixels. These
fields are used if you want to precisely position or size an object. The fields along the bottom of the
box are used to configure custom embedded function keys on those Datapanel models that have
function keys. (Some models, such as the 30/35, do not have function keys.)

If this is not the first page you have designed for this database, click the Previous or Next
button to move between pages until you find the desired page.

To select from a list of available pages, click the Browser button.

The Main toolbar provides easy access to functions that are common to many DataDesigner dialog
boxes. The Graphics toolbar provides easy access to functions used to create graphic pages.
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New page

Save page

Delete page
Open
Graphic Browser

Graphic page
(touch screen
grid displayed)

Graphic objects

Alignment
toolbar

Graphic toolbar:
see tooltips for
functions

Figure 6-1.  Graphics Page Editor – Datapanel Model 240E Example
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Alignment Tool

The alignment tools are used to align selected objects with
respect to each other.

Location Tool

The cursor location fields indicate the
current location of the mouse pointer.
The object location fields indicate the
location lower left corner of the
selected object. Coordinates are
measured from the lower left corner
of the Graphics page.

Using the Pop-up Menu
When the mouse pointer is within the graphic page, clicking the
secondary mouse button accesses the pop-up menu shown to the
right. The choices that are available depend on whether an object is
selected and the type of object selected.  Menu choices that are not
available for a particular object are grayed out.

Undo, Cut, Copy, Paste, and Delete all perform the same functions
as the corresponding items on the Edit menu.

Configure opens a Configure dialog box for the selected object
(same as double-clicking on the selected object).

Toggle orientation rotates the selected object(s) 90 degrees to the
left or returns the object to the vertical position.

Group and Ungroup perform grouping operations on selected
objects.

Align to allows you to select left, right, top, bottom, horizontal center, and vertical center
alignment for selected objects.

Z order provides the ability to rearrange the stacking order of graphics. When this item is selected,
a drop-down list will appear with three selections:

•  Send to back causes the selected graphic(s) to be moved behind all other graphics.

•  Shuffle overlaid causes the stacking order of overlaid items to be changed by
bringing the graphic on the bottom up to the top.

•  Edit Z order allows you to arrange the stacking order without limitation. When
this item is selected, the Overlaying Order dialog box will appear, displaying the
selected objects. Using the drag-and-drop technique, the objects in the list can be
placed in any order.
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Operations Common to all Objects on the Page
All the objects you place on the page are controlled by the operations listed below. Most of these
are the normal Windows operations.

Selecting Objects

•  Click on the object to select it.

•  Click and hold the left mouse button while you draw a rectangle around the object.

•  Holding the Control key (CTRL) down while left-clicking on objects will add the objects
to the current selection.

Sizing Objects

•  Click-and-drag the handles on the object in the normal Windows manner to change the
size of pushbuttons, bitmaps, or other “shapes.”

Moving Objects

•  Select the object.  Place the mouse pointer over the object so that the pointer turns to a
hand.  Click and drag in the normal Windows manner.

OR

•  Select the object, then press one of the arrow keys for the desired movement direction.
The object will move one pixel per key-press.

Cut/Copy/Paste

Displayable objects, including tags, their values, or other displayable attributes, can be cut, copied
and pasted in the normal Windows manner.  These operations may be applied to the same database
or a different database.

Editing Existing Objects

To open the Configure dialog box for an object, double-click on the object or select the object,
click the right mouse button and choose Configure from the pop-up menu.
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Static Attributes of Graphic Objects

Height, Width, Justification and Direction

This portion of some dialog boxes allows you to define the orientation and size of the displayed
Text or Message object.

Height/Width. Use the up-down arrows on the Height and Width fields to select the multiplier
values for the height and width of the item.

Direction. Click the arrow on the Direction field to access the drop-down list and click the desired
item direction (orientation), horizontal or vertical, or click the appropriate checkbox.

Width and Offset

When the selected field is text, the Width/Offset fields in the dialog box become active. These
fields specify how the field is to be displayed.
•  Width is used to allocate the number of characters to be displayed. For example, if Width is

set to 5, only 5 characters will be displayed for a particular field regardless of how long the
string is.

•  Offset is used to determine at which character position the display of the text string will start.
Setting the Offset to 2 will cause the display to start at the third character of the full text string
for that particular field.

Example: Width and Offset
 The selected field is 10 characters long.

 T  H  E  R  M  I  S  T  E  R
 Width is set to 5, Offset is set to 2.

 T  H  E  R  M  I  S  T  E  R
 The text string displayed is:

   E  R  M  I  S    

Font Selection

 You can select a font for any configurable texts (text object, message, value, or status text, etc).
To change the font, select the text item and click the “A” tool on the graphic configuration toolbar.
The Font dialog box will appear.
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Font Dialog Box

This dialog box allows you to choose a font for a selected text object.

Select Font
Lists the fonts available and indicates which fonts are loaded into the database. (ANSI DP 5x8 is
permanent for the DP150/160/240E.) When you select a font and click OK, the font is loaded into
the database.

Once a font is selected, it stays the default font for all new items until it is changed, or
DataDesigner is closed.

Note: Each additional font that you load uses space in the database.

Sample
Provides a preview of the selected font.

Remove From Database
Removes the selected font from the database.

Database Used
Indicates the amount of database space used by all loaded fonts.
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Tag Attributes
Tags have several attributes that can be displayed or used to control dynamic properties of graphic
objects. The items available in the configuration dialog box will depend on the tag type as shown in
the following table.

 Table 6-1  Field Types Available

Analog Digital

Tag Value Tag Value

External Lower Status Text 0

External Upper Status Text 1

Internal Lower Status Text 2

Internal Upper Status Text 3

Alarm Lower Alarm Type

Alarm Upper Tag Name

Alarm Type Status

Dynamic Display
You can specify dynamic properties for most display objects. The dynamic properties of a graphic
object determine how it is displayed in Run Mode on the Datapanel when the parameters of the
associated tag meet the defined conditions, such as certain values or alarms.

To configure dynamic display attributes for a graphic object, first create a new object or select an
object and choose Configure from the popup menu. Depending on the type of object selected, the
configuration dialog box will display dynamic properties tabs for Show/Hide, Blink, Position,
Rotation, and Fill attributes.

Show/Hide and conditional blinking require either digital tag input or alarm state input from either
digital or analog tags, not necessarily the same tag being displayed. Position requires the use of
analog tag input.
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Table 6-2.  Configurable Object Attributes

 Object  Type  Static Attributes  Dynamic Attributes
(Properties)

 Text  None  Height, Width, Direction,
Justification

 Show/Hide, Blink,
Position

 Analog Tag  None  Height, Width, Direction,
Justification

 Show/Hide, Blink,
Position

 Digital Tag  None  Height, Width, Direction,
Justification

 Show/Hide, Blink,
Position

 Drive Out  None  None  None

 Bitmap  Static  None  Blink, Position

 Bitmap  Discrete  None  Blink, Position

 Bitmap  Limit  None  Blink, Position

 Bitmap  List  None  Blink, Position

 Touch Region  None  Flash, Border
characteristics

 None

 Trend  None  None  None

 Message  None  Height, Width, Direction,
Justification

 Position

 Pushbutton  None  Style  None

 Line  None  Width  Show/Hide, Blink,
Position, Rotation

 Shape  None  None  Show/Hide, Blink,
Position, Rotation, Fill

 Meter  None  Character size for labels  None

 Trend
Recorder

 None  Character size for labels  None

 Frame  Raised or
Recessed

 Side width  Show/Hide, Blink,
Position

 Circle  Unfilled  Line width  Show/Hide, Blink,
Position, Rotation

 Circle  Filled  None  Show/Hide, Blink,
Position, Rotation, Fill

 Rectangle  Unfilled  Line width  Show/Hide, Blink,
Position, Rotation

 Rectangle  Filled  None  Show/Hide, Blink,
Position, Rotation, Fill

You can make the attribute dependent on the tag associated with the object or on some other tag.
For instance, a Tag Display object may display motor speed with blinking controlled by an alarm
on motor temperature.
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Dynamic Display Examples

Object Blinking Controlled by Object Tag

An analog tag has been configured to display the numeric value of Motor Speed, the rpm of a
particular motor. The display is also controlled by the tag value so that it blinks if the Motor Speed
tag value exceeds one of the alarm limits.

Object Blinking Controlled by Tag Other than Object Tag

In this example, the blink attribute of the Motor Speed tag display is controlled by the
characteristics of the Motor Temperature tag. The Motor Speed tag display blinks if the Motor
Temperature tag value exceeds one of the limits.
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Cutting, Copying, and Pasting Graphic Pages
Pages can be cut, copied and pasted from one page to another within a database or from one
database to another using the Graphic Browser as detailed in the procedures below. The standard
shortcut keys for these functions, Ctrl+X, Ctrl+C, and Ctrl+V, can be used. You can also access
these functions by clicking the appropriate buttons on the toolbar.

    

Using these functions, you can Cut/Copy/Paste in a variety of ways:

•  A whole page to a blank page in the same database.

•  A whole page to a blank page in some other database.

•  A whole page to an occupied page (overwrite) in the same database.

•  A whole page to an occupied page (overwrite) in another database.

Note: There are a couple of other ways to select objects/pages.  You can use
the mouse cursor to draw a box or “rubber band” around the object(s) or
even the entire page to be cut/copied. You can also use the drop down
menu from the tool bar or the keyboard (Control-A) to Select All, then
cut or copy.

General Information Regarding Cut/Copy/Paste

The Cut, Copy and Paste functions use the Windows clipboard. You can Cut/Copy from one
database, change to a different database and Paste into it. You can Cut/Copy from one database,
exit the DataDesigner program, do whatever you need to do (as long as you don't Cut/Copy from
another application into the clipboard), start DataDesigner again, and Paste the page into the newly
selected database.

When a database is opened, the Sizes listed by the
Graphic Browser are the actual number of bytes
used by in a Datapanel database. When you paste,
or add new elements to a page, the Byte Size
column is updated, but only with an estimate of the
size it will use.

Cutting a Page

To cut a page from a database to the Windows
clipboard:

1. A page (any page) must be visible in DataDesigner.

2. Click the Browse button on the Graphic page toolbar to display the Graphic Browser.

3. Click the number of the desired source page in the Graphic Browser window. The source page
will be displayed in the Graphic page window.
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4. Click the Cut button on the main DataDesigner toolbar (the scissors). You will be prompted to
be sure you want to Delete (cut) that page from the database.

5. If you click OK to the delete query, the selected page will disappear, the next lower page in the
database will be displayed, and the contents of the Cut page will be placed in the Windows
clipboard.

6. If you click No, nothing will be lost and nothing will be placed in the clipboard.

Copying a Page

To copy a page from a database to the windows clipboard:

1. A page (any page) must be visible in DataDesigner.

2. Click the Browse button on the Graphic page toolbar to display the Graphic Browser.

3. Click the number of the desired source page in the Graphic Browser window. That page will
be displayed by DataDesigner.

4. Click the Copy button on the main DataDesigner toolbar (the double page button next to the
scissors).

5. There will be no apparent change in the display, but the contents of the page will be placed in
the Windows clipboard.

Pasting a Page

To paste a page from the Windows clipboard to a database:

1. A page (any page) must be visible in DataDesigner.

2. Click the Browse button on the Graphic page to display the Graphic Browser.

3. Click the number of the target page into which you want to paste the contents of the clipboard.
If you want to paste into an empty page, you must click the Expand button to see all pages.
(Empty pages have a Byte Size value equal to 0.) Click the desired page. The contents of that
page will be displayed.

4. Click the Paste button on the DataDesigner main toolbar (the small clipboard button).

5. If the target page was empty, it will now appear with the source page data that was in the
clipboard. The Graphic Browser column "Byte Size" will be updated with an estimate of the
number of bytes consumed by that page.

6. If the target page contained elements, the About to Destroy Graphic Page dialog box will
appear. Click OK to replace the contents of the target page with the page on the clipboard.
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Displaying Information on the Page

Many kinds of information or data can be displayed on a Datapanel page, such as text, analog tags,
digital tags, bitmaps, touch regions, trend charts, and bar graphs. Each of these is discussed below.

Caution

When objects are grouped, the Editable attribute is cleared or reset for any
tag objects in the group.  On screen editing, as enabled by this attribute, is
not allowed when the tags are grouped.

Text Objects
Static text objects are individual text strings that appear on a particular page. You can use
static text for titles, explanatory information, messages, labels, etc. (To create and store text

strings that are controlled by tag values, use the Message feature.)

Click the Text button to initiate the text display operation. Move the mouse pointer to the location
on the page where you want the text to appear. Click and hold the left mouse button, drag a
rectangle of the desired size and location, release the button. The Formatted Text Display dialog
box will appear.

Formatted Text Display
Formatted Text display provides
justification and word wrap within the
text formatting box. The formatting box
is the rectangle “pulled” on the screen
when the object is first placed; it is not
visible at run time. Formatted Text
display supports “hard” or embedded
carriage returns to force a new line.

•  Enter the desired text into the Text
field.

•  Select the height, width,
justification, and orientation of the
text.

•  Click OK to exit the dialog box.

7
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Message Tables
A message table allows you to assign text strings to values of a tag. A text string is
displayed when the tag’s value is less than or equal to the assigned value. Once you have

created a message table, you can configure the message display.

To display a message, click the Message button. Move the mouse pointer to the location on the
page where you want the message to appear. Click and hold the left mouse button, drag a rectangle
of the desired size and location, and release the button to create the formatting box. The Message
Display dialog box will appear.

Message tables are available in Datapanel models 150, 160 and 240E. Other models,
30/40/50/60/80, use the Page Change mechanism to display text on different pages based on a
value in the controller.

Example:

0 TEXT0 Displays for 0

10 TEXT10 Displays for 1-10

20 TEXT20 Displays for 11-20

65535 TEXT30 Displays for 21-65535

Message Display Dialog Box

Before you can configure a
message display, you must create a
message table. (See "Configuring
Message Tables" in Chapter 5.)

Tag — Select the tag that you want
to control the display of messages
in the message table.  For
information about creating tags, see
Configuring Tags

Message Table — Select a
message table from the drop-down
list.

Character Size — Select the
height and width of the message
characters. These are multiples of the default character size.

Text Orientation — Select horizontal or vertical orientation of the message display.

•  Text Justification — Select left, center, or right justification. This determines the horizontal
position of the text in the display box.
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Adding a Tag Display to the Page
Digital tag displays present the value or other attribute of the digital parameter associated with the
digital tag.

Analog tag displays present the scaled value or other attribute of the analog parameter associated
with the analog tag.

Click the Tags button on the Graphics toolbar to initiate the analog tag display operation. Move the
mouse pointer to the location on the page where you want the text to appear. Click and hold the left

mouse button, drag a rectangle of the desired size and location, release the button. The Tag
Display dialog box will appear.

Tag — Select the tag that you want to display from the drop-down list.  For information about
creating tags, see Configuring Tags.

Display Field — Select the tag attribute to be displayed. The attributes available depend on the
type of tag selected.

Character Size — Select the height and width of the tag display characters. These are multiples of
the default character size.

Text Orientation — Select horizontal or vertical orientation of the tag display.

Text Justification — Select left, center, or right justification. This determines the horizontal
position of the tag in the display box.

Display Style — Width determines the number of characters displayed (starting from the left).
Offset determines the number of characters, starting at the left of the display, that will be truncated.

Editable — If this box is checked, the tag display is given the Editable attribute, enabling the
operator to modify it in the Datapanel on-screen edit mode.  The Datapanel operator’s procedure
for selecting and editing tag displays varies according to Datapanel model. See the “Editing Tag
Displays in Datapanel On-Screen Edit Mode” for details.
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Editing Tag Displays in the Datapanel On-Screen Edit Mode
The following procedures describe how to use the Datapanel on-screen edit mode to edit tag
displays that have the Editable attribute.

Datapanel 240E
1. To begin the on-screen edit mode, press the Enter key.
2. Press the arrow keys to move the cursor to different editable on-screen tags, then press the

Enter key again to select the tag to edit. The keypad pops up on the screen.
3. Use the keypad, which displays numbers for editing numeric tags and alpha characters for

editing text tags, to edit the tag display.
4. Press the Enter key to accept the new tag value (or text).
5. Press any other key to end the Edit.

To cancel Edit without changing the existing value (or text), use the Backspace key to blank the
entry box, then press Enter. You can also end the edit by pressing the ESC key on the keypad.

Datapanel 150/160
1. To begin the on-screen edit mode, press the Enter key.
2. Press the arrow keys to move cursor to different on screen tags.
3. Using the numeric keypad, enter the new value. (For on-screen editing of text tags, a numeric

key must be pressed to display the alpha characters in the function key label area.)
4. Press CR to accept the new value.

To cancel Edit without changing the existing value (or text), use the Backspace key to blank the
entry box, then press Enter.

Datapanel 40/45/60/65
1. To begin the on-screen edit mode, press the Enter key.
2. Press the arrow keys to move the cursor to different editable on-screen tags, then press the

Enter key again to select the tag to edit.
3. Use the arrow keys to increase or decrease the value.
4. Press the Enter key to accept the new value.

To cancel Edit without changing the existing value, use the Backspace key to blank the entry box,
then press Enter.

Datapanel 85
1. To begin the on-screen edit mode, press the Enter key.
2. Press the arrow keys to move the cursor to different editable on-screen tags, then press the

Enter key again to select the tag to edit.
3. Enter the new value from the keypad, then press the Enter key to accept the value.

To cancel Edit without changing the existing value, use the Backspace key to blank the entry box,
then press Enter.
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Adding a Bitmap to the Page
Bitmaps can be displayed on Datapanel models DP160 and DP240. Bitmaps can be used in four
ways:

! Static - to form a general background on a Datapanel display.

! Discrete - to indicate the state of a Digital Tag.

! Limit - to indicate that a limit for an Analog Tag has been violated.

! List - a series of bitmaps can be configured to represent values in an analog range. For
example, they might be pictorial representations of a dial in various pointer positions to
represent pressure readings.

Bitmaps are stored in the directory created during installation: BITMAPS (two-color bitmaps for
use with monochrome displays).  A number of bitmaps are supplied by DataDesigner, but any
Windows compatible, monochrome BMP file may be used by placing it in the BITMAPS
FOLDER. Bitmaps will be rejected if a bitmap for monochrome contains a palette of more than
two colors, even if only two or less are used.

Click the Bitmap button to initiate the bitmap display operation. Move the mouse pointer to
the location on the page where you want the lower left corner of the bitmap to appear. Click.

The Bitmap Display dialog box will appear.. The exact procedure to add the bitmap depends on the
style of bitmap display selected. See Chapter 11 for detailed information on using and configuring
bitmaps.
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Adding a Trend Record to the Page
A Trend Record is a wizard-produced trend chart. The Trend Record Wizard allows you to format a
trend chart quickly and easily. The wizard supports extensive scale and labeling capabilities.

A maximum of 25 trends can be configured. These can either be displayed in Trend Records or the
older style Trend Charts.  The maximum number of trend-related tags permitted per page is four.
These tags can be in either Trend Records or Trend Charts. The number of Trend Records/Charts
permitted on a page can be any arrangement with a total of four tags. Some possible arrangements
are shown in the following table.

Number of Trend
Records

Number of Trend
Charts

1 2

2 0

4 0

0 4

One tag per record is allowed.

  To initiate Trend Record design, click the Trend Record button. Move the mouse pointer to
the location on the page where you want the text to appear. Click and hold the left mouse button,
drag a rectangle of the desired size and location, release the button. The Trend Recorder dialog box
will appear.
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Trend Recorder Dialog Box
A maximum of 25 trends can be configured. Use this dialog box to select the tag information that a
Trend Recorder will display and configure the Trend Recorder’s appearance.

Trend

Tag
Select a tag from the drop-down list. You can display one tag on each Trend Recorder.   For
information about creating tags, see Configuring Tags.

Frequency
Use this section to select the frequency (time interval) in seconds at which the chart will be
updated. This time should be slower or equal to the refresh rate of the tag. The frequency will
determine how often a sample of the value will be taken and plotted on the trend. The number of
samples taken is fixed at 120 samples for all models supporting trends. This means that if a
frequency of 1 second is selected for a trend on a 240E display, 240 samples will be taken 1 second
apart from one another and the total time elapsed from one end of the chart to the other would be
four minutes. After that, old data is lost and new data is added to the end of the trend line.

X Scale, Y Scale, and Width
Use this section to select the scales you want to appear on the chart and to adjust the width of the
chart.

•  Check the scales you want: X, and Y.
•  Adjust the width of the chart box using the Width arrows.
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Lower Limit/Upper Limit
These fields are available only if upper and lower limits have been configured in the Tag Editor.

Optional Labels and Fields

Use this section to format the chart parameters.

•  Check the Trend Recorder labels you want:  Title, X Label , and Y Label.
•  From the drop-down list, select one of the labels.
•  Enter the appropriate text for that label in the text field. (Title, X Label, and Y Label)
•  Adjust the width and height of the label using the Width and Height arrows.
•  Repeat for each label.

Default
Many of the configuration choices can be saved and automatically applied to other Trend
Recorders as they are created. To save the present Trend Recorder configuration as the default
configuration for future Trend Recorders, click the Default button.

Adding a Trend Display to the Page
When the Trend Record does not meet your needs, you can custom configure a trend chart. Trend
charts allow you to display the time variation of a tag. Up to four charts may be configured on each
page, with a maximum of 25 trends per database. This option is only available on the 160 and 240E
Datapanels.

Click the Trend Display button. Move the mouse pointer to the location on the page where
you want the display to appear. Click and hold the left mouse button, drag a rectangle of the

desired size and location, release the button. The Trend Display dialog box will appear.

Trend Display Dialog Box

Tag
Select a tag from the drop-down list. For
information about creating tags, see
Configuring Tags.

Frequency
•  Click the up-down arrows on the

Frequency field to select the update
interval in seconds. This time should be
slower or equal to the refresh rate of the tag. Note: 120 samples are taken for the Trend line at
the frequency specified. For example, if a frequency of 1 second is specified, 120 samples,
each taken 1 second apart, will result in an overall trend period of 2 minutes.
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Adding Lines and Shapes to the Page
Lines can be placed on the page either as simple straight lines suitable for formatting tables and
charts or they can be made of multiple segments of different length and orientation. The width of

the line can be adjusted.

To add a line or shape, click the Lines or Shape button. Move the mouse pointer to the
location on the page where you want the line to begin. Click and hold the left mouse button,

drag the end of the line to the desired line length and location, and release the button. Add
subsequent segments by clicking the mouse at the desired locations.

When all segments have been drawn, double click. The Lines or Shape Display dialog box will
appear.

Lines or Shape Display Dialog Box

•  To convert the line to a shape,
select Shape.

•  Click Freeze nodes to lock the line
nodes in relation to each other. You
can use Freeze Nodes to avoid
accidentally changing the line node
relationships when moving the
whole line.

•  Click the up-down arrows to adjust
the width of the line. This box is
not active if Shape is selected.

•  For shape and line objects, you can
configure show/hide, blink,
position, and rotation. For shapes,
you can also configure dynamic fill. If there is no dynamic fill, the shape is just a solid, filled-
in polygon.
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Editing Lines on the Page

You can change existing lines by adding a node, deleting a node, or by moving a node. You can use
the Freeze Nodes box in the Lines or Shape Display Dialog Box to unfreeze a node before you can
alter it.

Inserting a Node
Move the mouse pointer to the desired place on the line. When the pointer changes to a four-headed
arrow, click the left mouse button to place a new node on the line. The new node can then be
dragged to a new location to change the shape of the line.

Deleting a Node
Move the mouse pointer to the desired node on the line. When the pointer changes to a four-headed
arrow, click the left mouse button to select the node. Press the Delete key to remove the node. The
line will assume a new configuration without the deleted node.

Moving a Node
Move the mouse pointer to the desired node on the line. When the pointer changes to a four-headed
arrow, press the left mouse button to select the node. Drag the node to the desired location and
release.
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Adding a Meter to the Page
The meter consists of a bar chart that can be sized. A method is provided to simply and quickly add
a title, units specification, tag-based numeric values, alarm bars, and scales. These features may be
specified to appear in a selected color (black or white).

 To add a meter, click the Meter button. Move the mouse pointer to the location on the page
where you want the lower left corner of the meter to begin. Press the left mouse button and drag the
mouse to the desired size and shape desired for the meter. Release the mouse button. The Meter
dialog box will appear.

Meter Dialog Box

Meter

Tag
Select a tag from the drop-down list.
For information about creating tags, see
Configuring Tags.

Alarm Bar
If selected, an alarm bar will be
displayed to the left of the bar chart.

Scale
Displays a scale to the right of the bar
chart.

Bar Width
Set the width of the meter in pixels.

Upper Limit
Enter an upper limit scale value. This value must be greater than the Lower Limit value. Maximum
value for this parameter is determined by the upper limit configured in the Tag Editor.

Lower Limit
Enter a lower limit scale value. Must be less than the Upper Limit value. Minimum value for this
parameter is determined by the lower limit configured in the Tag Editor.
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Optional Labels and Fields

Title
Displays a title on the meter. Type the title in the text box.

Tag
Displays the tag name on the meter.

Value
Displays the tag value on the meter.

Unit
Displays the tag units on the meter. (Configured in the Tag Editor.)

Limits
Displays the meter upper and lower limits on the meter.

Character Size
Select the label item from the drop-down list for character size.

Width/Height
Use the up-down arrows to configure width and height multipliers for characters in the selected
label.

Default
To save the meter settings and apply them automatically to future meters, click the Default button.
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Adding Geometric Objects to the Page
You can add frames, circles and rectangles to a page. To add one of these objects, click the
appropriate button on the toolbar.  Place the object where you want it to appear on the page. The
Configure dialog box for the geometric object will appear.

You can configure the following dynamic properties for these objects: For more information about
configuring dynamic properties, see “Dynamic Display” in Chapter 6.

Object Style Properties

 Frame Raised Show/Hide, Blink, Position

Recessed Show/Hide, Blink, Position

 Circle Unfilled Show/Hide, Blink, Position, Rotation

Filled Show/Hide, Blink, Fill, Position, Rotation

 Rectangle Unfilled Show/Hide, Blink, Position, Rotation

  Filled  Show/Hide, Blink, Fill, Position, Rotation

Frame Dialog Box

A frame can be either Raised or
Recessed. For either style, you can
configure Side width, which
determines the width of the shaded
edge. Type a value in the Side width
field or use the arrows to select a
width.



7-14 DataDesigner Software User's Guide – November 2001 GFK-1658B

7  

Circle and Rectangle Dialog Boxes

The configuration of circles and
rectangles is similar. Select either the
Circle or Rectangle button from the
Graphic toolbar, place the mouse
cursor over the page at the point where
the circle or rectangle is to be placed
and click the left mouse button. While
holding the left button, drag the cursor
to draw a rectangle or circle of the
desired size and release the button.

Circles and rectangles can be either
Unfilled or Filled. If Unfilled is
selected, you can configure Line width.

When Filled is selected, the Fill tab
appears, which allows you to configure animated filling of the object.
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Grouping Graphics
A graphic group is a collection of objects that are treated as a single unit. Objects can be grouped in
order to maintain spatial relationship and display order on the page, or to cause a series of objects
to refresh as a unit whenever any one object changes. The objects can be edited individually when
they are ungrouped. Each object continues to support its full range of dynamic attributes after
grouping. The stacking order of the objects before grouping can be adjusted using the Z-order
feature accessed by clicking the right mouse button. This stacking order will be maintained after
grouping, assuring that the objects are always drawn in the same order.

Caution:

When objects are grouped, the Editable attribute is cleared or reset for any
tag objects in the group.  On screen editing, as enabled by this attribute, is
not allowed when the tags are grouped.

To create a group:
•  Select the desired graphics objects by holding the Shift key and clicking each graphic you want

to include in the group, or draw a box around the object you want to group.

•  Click the right mouse button.

•  Select Group from the Layout menu.

To ungroup:
•  Select the group.

•  Click the right mouse button.

•  Select Ungroup from the Layout menu.

Using Templates
Any graphic page can be used as a basis for other pages in the same project. Using a template page
simplifies the design operation when the same information or layout is repeated on a number of
pages. It also saves database space.  Once the template has been added to a page, the template
cannot be selected or edited from that page. It can be edited on its own page.

•  Templates cannot be nested. That is, a page configured with a template cannot be used as
a template and still retain the graphics of the original template. Rather, the non-template
contents of the page will be added to the new page as a background.

•  Only one source template can be assigned to any given target page.

In the Datapanel, the template and the page graphics are combined into a single dynamic graphic.

To create a template, choose Template from the Layout menu.
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Graphics Grid
The grid feature of DataDesigner helps you place objects on the graphic page in an orderly
arrangement.

The grid can be turned on or off from the Layout menu or the right-mouse pop-up menu. The grid
must be turned on before you can display it. (Select Grid On from the Layout menu.)

To configure the graphics grid, select Set Grid from the Layout menu. The Set Graphics Grid
dialog box will appear.

Set Graphics Grid Dialog Box

Grid Units
Grid units refers to the number of pixels defined as a
grid increment. For instance, a Grid Unit setting of 5
means that there is a grid location at every fifth pixel.
Thus, Grid Units is a measure of the "coarseness" of
the grid. A Grid Unit setting of 10 would result in a
coarser grid than a setting of 3. A Grid Unit setting of
1 means that you can place an object at any pixel.
This is equivalent to not having the grid turned on.
The horizontal and vertical Grid Units can be set
independently. The optimum setting of the Grid Units
depends on the nature of the page layout and your
personal preferences.

Grid Lines
In addition to setting the grid coarseness, you can control how many grid locations appear as lines
on the screen. A Grid Lines Spacing of 1 means that every grid location will appear as a line on the
screen. A Grid Lines Spacing of 3 means that every third grid location will appear as a line on the
screen. This setting allows you to control the visual clutter on the page independently from the
actual grid coarseness.

The Show/Hide option allows you to turn off the visual display of the grid. The Show/Hide
function can also be accomplished by clicking the Graphics Grid On/Off option on the right-click
pop-up menu.

If Grid Units is set to one and the Grid Lines Spacing is set to one, it will appear that there is no
grid on the page because this setting results in a grid line being drawn at every pixel.
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Configuring Operator Input

The Datapanel allows the operator to interface easily with both the controller and the Datapanel.

Embedded Function Keys
Any function key (F-key) on any page can be programmed to provide a custom operator input
function. In addition to programming F-keys for useful functions, you can program an F-key to
prevent an operator from accessing the normal F-key function for any given page.

Note: Datapanel models 3x and 5x do not have a default or normal operation;
they can only be programmed for a specific purpose.

Touch Regions
The display area of Datapanel model 240E is overlaid with a resistive touch membrane providing
touch-screen operation. The membrane divides the display area into rectangular touch regions
which are organized in rows and columns. These regions are programmed much like function keys.
The incremental regions can be combined to create larger touch regions. The touch membrane is
composed of a matrix of 8 rows of 6 columns, which can provide up to 48 touch regions.

Push Buttons
The display area of the touch model can be configured with push button functions. The push button
icon can be configured to emulate the various operation capabilities of mechanical push buttons.

Editable Tag Displays
Tag Value displays can be given the editable attribute by checking the Editable Box on the Tag
Display dialog. Then, by pressing <Enter> on the panel, the operator can navigate among any
Editable Tags on the screen, select a tag to edit and modify the value on screen.

Operator Write (Drive Out)
Tags can be designated as Drive Out points. When the Drive Out function key is pressed by the
operator, a numbered list of drive-out points is presented. The operator selects which point to drive
out. The operator will then be requested to input the desired value. This value is then transmitted to
the selected tag.

8
Chapter
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Configuring Embedded Function Keys
On the page design screen, double click the F-key you want to reprogram. The Function Key
Operation dialog box will appear. The appearance of the lower portion of the box will vary
according to the operation selected. The illustration shows the appearance of the box for the Write
operation.

•  Specify the tag and a label for the function key.

•  Click the arrow in the Operation field to access a drop-down list. Select one of the following
options. For details, refer to the page listed.

Write –  page 8-7

Jog – page 8-8

Toggle – page 8-9

Ramp – page 8-10

Recipe Load/Transfer – page 8-11

Macro – page 8-13

Goto – page 8-16

•  Click OK to return to the page design screen.
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Adding a Touch Region to the Page
Click the Touch Region button to initiate the touch region design operation. Move the mouse
pointer to the location on the page where you want the touch region to be located. Touch

regions may only be located on the rectangular grid formed by the touch membrane. Add the touch
region by performing one of these operations:

•  Click the left mouse button at the desired location. A rectangle of the default size will be added
to the page. The region can be moved and sized after configuration.

•  Click and hold the left mouse button, drag a rectangle of the desired size and location, release
the button. The region can be moved and sized after configuration.

The Touch Region Operation dialog box will appear.

Note: The touch region can be identified by overlaying with either a text tag or
a bitmap. The touch region and the identifying text tag or bitmap are
independent.

See Chapter 11 for advanced information on using bitmaps.
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Touch Region Operation Dialog Box

Operation Tab

The appearance of this dialog box will change when you select an operation type.

Select an option from the Operation list. (The list of available operations will depend on the
Datapanel model.) The appearance of this dialog box will change when you select an operation
type.

Write –  page 8-7

Jog – page 8-8

Toggle – page 8-9

Ramp – page 8-10

Recipe Load/Transfer – page 8-11

Macro – page 8-13

Goto – page 8-16

Touch Style Tab

Flash Style —  When Flash Border is selected, the border will blink when touched (blink on or off
depending on the Status selection).  When Flash Interior is selected, the insides of the touch region
will blink when touched.

Border Status — When the border status is On, the border will be displayed at all times. When the
border status is Off, the border of the touch region will not be displayed on the Datapanel screen
except while the operator is actually pressing the touch region.

Border Width — Sets the border width. A value of 0 causes no border to show, even if border
status is On.

See Chapter 11 for information on using bitmaps.
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Adding a Push Button to the Page
Push buttons provide added ease and versatility for output operations. Push buttons can be
considered touch regions with images representing the four states of the button.

The four states are unpushed-unlit, pushed-unlit, unpushed-lit, pushed-lit. Therefore the first two
are shown when the lamp tag is unused or 0. The second two are used when the lamp tag is 1.

Click the Push Button button to initiate the push button design. Move the mouse pointer to
the location on the page where you want the button to appear. Click and hold the left mouse

button, drag a rectangle of the desired size and location, release the button. (The region can be
moved and sized after configuration.) The Button Operation dialog box will appear.

Button Operation Dialog Box

The lower left corner of the box varies according to the Operation selected. The illustration shows
the appearance of the box for the Toggle operation.

Operation
Select an option from the Operation list. (The list of available operations will depend on the
Datapanel model.) The appearance of this dialog box will change when you select an operation
type.

Write –  page 8-7

Jog – page 8-8

Toggle – page 8-9

Recipe Load/Transfer – page 8-11

Macro – page 8-13

Goto – page 8-16
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Button Style Tab

The selection of button styles that appears in the Button Style scroll bar window depends upon the
Datapanel type.

•  Use the scroll bar across the top to view available button styles. Click the desired style.

•  If applicable, specify the Lamp Tag. The button display acts as if there is a "lamp" inside the
button, i.e., the button is brighter when the lamp is lit and darker when the lamp is not lit. The
lamp tag must be digital and is used to determine whether the button lamp is to be illuminated.

•  Specify the text for the button. For Toggle buttons only, specify text for the Off and On states.

•  Click OK to return to the graphic page screen.

Configuring Output Operations
When you configure an embedded function key, pushbutton, or a touch region, you can select from
the following types of output operations:

•  Write - writes a specified value to a tag

•  Jog - causes a digital tag value to assume a new state as long as the key is pressed and then
return to the opposite value when the key is released.

•  Toggle - causes a digital tag value to alternate between two values

•  Ramp - causes an analog tag value to change incrementally (not available for pushbuttons)

•  Recipe Load/Transfer – loads preconfigured values into the associated tag, and/or
transfers the current values of the recipe tags to the controller (either or both operations
can be selected)

•  Goto – displays the specified graphic page

•  Macro – causes a custom-configured operation to be performed
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Configuring Write

The Write function enables the operator to drive out specific values directly to analog tags or
digital tags. In the Run Mode, each time this F-Key, touch region, or push button is pressed, the
value will be written to the associated tag. This application is useful for resetting process. If no
value is entered during configuration, an operator prompt will appear asking the operator to input a
value.

To configure a write operation:

•  Select Write. The dialog box will change appearance to provide the fields necessary for
write configuration.

•  Select a Tag.

•  If desired, click the value checkbox and enter a value in the Value field. If you leave the
value unchecked the operator will be prompted for a value when the function key, touch
region, or pushbutton is pressed.

Click OK to return to the page design screen.

•  If you want a single value to be hard coded, enter a value in the Value field.
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Configuring the Jog Function

The Jog option performs the function of a momentary push button that enables the operator to
output a value to the PLC for as long as the button is pressed or to output a value in short bursts by
pressing the button repeatedly.

To configure the jog operation:

•  Select Jog. The dialog box will change appearance to provide the fields necessary for jog
configuration.

•  Configure the following tags:

Feedback Tag. This is an analog tag that provides operator feedback to display the result
of the operation. (For example, the position of a machine part that is being jogged into
position.)

Output Tag. This identifies the PLC address assigned to this button function.

Lamp Tag. Optional for pushbuttons only. Controls the lamp on/off. Must be a digital tag.

Note: All of these tags must use the same Multicomms channel if configured.
DataDesigner will allow you to select different channels, but an error
will be generated at runtime if the second (and optional third) tag(s) do
not match the channel of the tag being jogged.

•  Configure the Active State.

Pressed Released

High 1 0

Low 0 1

•  Configure Refresh Interval. This is the rate at which the discrete value will be transmitted
and the feedback polled.
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•  Click the Exclusive Communication check box if you want the fastest possible feedback
time between the PLC and the Datapanel. This allows only the Output and Feedback tags
to run on the communications link. This stops all tags except the output and feedback tag
from running on the communications link. This will therefore stop all alarms while the
button is depressed.

•  Click OK to return to the page design screen.

Configuring the Toggle Function

When the Toggle option is selected, the inverse of the current value of the configured digital tag is
sent to the controller with each press of the embedded F-key, touch region, or push button.

To configure a toggle operation:

•  Select Toggle. The dialog box will change appearance to provide the fields necessary for
toggle configuration.

•  Select a Tag.

•  Click OK to return to the page design screen.

In the Run Mode, each time this F-Key, touch region, or push button is pressed, the associated tag
will toggle between digital values. This application is useful for switch-like on-off functions.

It is important to note that toggle requires feedback from the controller to work successfully.
Activating a toggle in the Datapanel causes the inverse of the value that the Datapanel has for the
tag to be sent. If the refresh of the tag is too slow, read after write was not selected, or there are
comms errors, the toggle will continue to send out the same value. Also, you cannot use Double bit
tags in a toggle operation.
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Configuring the Ramp Function

The Ramp function enables the operator to increase or decrease the value of a pre-selected analog
tag by a specified increment with each press of the up/down arrow keys.

To configure a ramp operation:

•  Select Ramp. The dialog box will change appearance to provide the fields necessary for
ramp configuration.

•  Select a Tag.

•  Enter a value in the Delta field. If the entered value is less than the smallest increment of
the tag, the value will be interpreted as zero.

•  Click OK to return to the page design screen.

In the Run Mode, when this F-Key or touch region is pressed, a prompt will appear displaying the
tag value to be written to the controller. The operator then presses the up/down arrow keys to
increment or decrement the tag by the programmed amount. When the desired value is reached, the
operator presses . This causes the displayed value to be written to the tag and to the controller.
Pressing  a second time will exit the ramp function.
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Configuring Recipe Load/Transfer

Touch regions, pushbuttons and function keys can be configured to implement the recipe load and
transfer functions. To use these functions, you must first create a named recipe group, which is a
list of recipe tags. This function loads preconfigured values into the associated tag, and/or transfers
the current values of the recipe tags to the controller (either or both operations can be selected).

To configure a recipe operation, select Recipe Load/Transfer in the Operation list box. The dialog
box will change appearance. Click the Configure Recipe button. The Configure Recipe Operation
dialog box will appear.

Recipe Operation Dialog Box

Recipe Name
Select the recipe group that you want to load and/or transfer.

Operations

Load
Loads preconfigured values into the tag. If you only select a Load operation, the values in the
recipe tags can be edited by the operator if standard operator/write are also configured.
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Transfer
Downloads the current values in the recipe tags to the controller. The only way to get a recipe value
to the controller is through a recipe transfer. (Writing to a recipe tag only updates the local copy of
the data.)

Tags in Recipe
Lists the recipe tags that make up the selected recipe group.

Values to Load
If the Load operation is selected, you must enter a value for each Recipe tag. (Digital tags can have
a value of 0 or 1.)

Completion Tag
If the Transfer operation is selected, you can select a completion tag, which can be either digital or
analog. The value specified will be driven out to this tag when the recipe tags have been sent to the
controller. If there is an error in transferring a recipe to the controller, the operation will halt at the
tag with the problem, and the standard communications error for that tag will appear. The rest of
the recipe tags and the completion tag will not be updated.

To select a completion tag, click the Browse button. The Tag Browser dialog box will appear.

Value to Send
If a completion tag is selected, you must specify a value to send.
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Configuring a Macro

Function Keys and Touch Areas may be configured as a Macro or multiple keystroke sequence.
This enables the operator to perform several operations with one keystroke. The following Macro
functions can be used separately or in combinations.

[GR] Graphic. Return to last page displayed.

[OV] Overview., Go to Overview browser.

[DO] Drive Out. Send a value to the PLC. The Drive Out [DO] function is used to change
values in the PLC. Drive Outs are used in Macro functions where more than one value may be
changed with an F-key or touch area or value changes are combined with page changes.

[MM] Mode. Go offline or make O/I adjustments.

[AL] Alarm. Go to Alarm screen (Models 150, 160, and 240E).

[AA] Alarm Acknowledge. One to acknowledge, two to clear (Models 150, 160, and 240E).

[PR] Print. Only available on graphics pages for 160 and 240E. (Macros can be
configured for Alarm Log and Overview, but Print is not supported on these system
pages.)

Creating a Macro

Double click a Function key or add a Touch Area to a Graphics page. Select Macro from the drop-
down list. If you are configuring a function key, enter the label you want to appear on the key (5
characters max).
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Click the macro keypad button to access the Macro Keypad dialog box (dialog for models
160/240E shown below). The Macro Keypad for model 150 is similar, except that it does not have
the Print key located above the Esc key.

The asterisk that appears in the macro string field of the dialog acts as a cursor. When you click a
function button, the function is entered in front of the asterisk. To move the asterisk forward and
back in the string, click the left and right arrow keys. This allows you to insert and delete in the
middle of a macro string rather than having to delete back to that point and re-enter the remaining
part of the macro.

The Macro Keypad dialog box for Datapanel Models 30/35/40/45/50/55/60/65/85 is shown below:
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Macro Examples

Page Changes
•  To create a Macro that goes to Graphics page 10:

In the Macro Keypad dialog box, click the keys: 1, 0, CR. 10[CR] will be displayed.Close the
Macro Keypad dialog box. Click OK in the Function Key or Touch Region dialog box to
accept the macro.

•  To go to the next page, click the down arrow key. [DN] will be displayed. Close and save.

•  To go to the previous page, click the up arrow key. [UP] will be displayed. Close and save.

•  To go to the last page displayed, click the Page button. [GR] will be displayed.

Off-Line
To create a macro that takes the Datapanel off-line or access operator setup functions
such as adjust contrast and enable alarms (150, 160, 240E), or reload the database
select [MM] mode function.  By default the Mode function is programmed on function

key F5. If this key function is removed from the user pages, the user has no means to go offline
unless the Datapanel is connected to a PC which is running the Datapanel Transfer Utility (see
Chapter 4, Placing Datapanels in Host Transfer Mode).

Maximum Macro Length
For Datapanel Models 150, 160, and 240, the maximum number of keystrokes that may be
contained in Macro is 25.  If the keystroke string needs to be checked, and the maximum number of
keystrokes exceeds the viewing window, use the left and right arrow keys in the Edit section of the
Macro Keypad dialog box.

Multiple Drive Out Macro

Complex Macros may be constructed to change both Analog and Digital tag values, with one
operator input. In the following example the operator will turn on the Digital Tag “Fan Motor” by
writing a 1, Set the Analog Tag “Process Setpoint” to 59, and change to page 2. After assigning
Drive Out 01 to Fan motor and Drive Out 02 to Process setpoint, the Drive Out string would look
like this: [DO]1[CR]1[CR][CR]2[CR]59[CR][CR][CR]2[CR].
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Configuring Goto

Touch regions, push buttons, and function keys can be configured to go to a different graphic page
when pressed.

To configure a Goto operation, select Goto from the Operations list. Enter the number of the
graphic page that you want to be displayed.
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Configuring Datapanel Communications

This chapter describes how to configure the Datapanel to communicate with the controller and with
other Datapanels.

Overview

Multicomms

Multicomms is a feature of Datapanels that allows two, possibly different, protocols to be loaded
into the panel. Each protocol utilizes a different communications port, thus allowing two PLCs to
be connected to the Datapanel. This feature is limited to panels with two ports. Additional
restrictions are:

•  Certain protocols (#25, #141, and #92) can not be loaded twice and can only be used on
COM1.

•  The embedded panels (160 and 240E) will use whichever serial port is free (if any) for
printing.

•  If a protocol is configured for both COM1 and COM2, serial printing is disabled. If COM2 is
used, serial printing will occur on COM1. If only COM1 is used, serial printing occurs on
COM2.

9
Chapter
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Multidrop

This configuration consists of connecting two PLCs to the same port by daisy chaining the two
devices together. This capability has both electrical and protocol-based requirements.

Electrical: The PLC or other device must have an RS422/485 interface. The DP 30, 35, 50, 55,
150, 160, and 240E models support RS485 on COM1.

Protocol: Some PLCs, regardless of their electrical interface, do not support multidrop. These are
called point-to-point connections or single-point connections. The remote address that would be
specified in the tags for these PLCs would not include a device or node ID.

In contrast, SNP or SNP/X protocols do support multidrop. The first field in the remote address is a
PLC name that is used to select which PLC on the network is to receive the request.

Port Settings
The Datapanel menu offers two choices:

•  Datapanel Com1 (for communications between the controller and the Datapanel)

•  Datapanel Com2 (for output to a printer or communication with another controller)

Selecting either of these choices opens the Protocol and Port Settings dialog box.

Datapanel Com1/Com2 Tabs

These tabs on the Protocol and Port
Settings dialog box are used to
configure data transmission
characteristics for the controller and
the Datapanels. The transmission
characteristics are controller-
dependent. These values must match
those configured in the controller. The
box is divided into four fields, all of
which must be configured. (The
Connection field is provided for
Datapanel 30, 35, 50, 55, and 150
only.)

Baud Rate
Select the rate by clicking on the
appropriate option box.
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Data Bits
This field is used to set the number of data bits in a character to be transferred. The number of data
bits may be either 7 or 8, but must match the setting in the PLC. Some PLCs only support certain
data lengths.

Select the number of bits by clicking on the appropriate option box.

Stop Bits
Select the number of stop bits to signal the end of a character by clicking on the appropriate option
box.

Parity
Select the desired form of parity by clicking on the appropriate option box. The parity selected for
the Datapanel must match the parity setting of the PLC.

Connection
The Connect field appears for Datapanels that require software selection of the electrical
connection. The drop-down list offers up to three choices:

•  RS232

•  RS485 Full (4 wire)

•  RS485 Half (2 wire)
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Connecting a Datapanel to Another Datapanel: Host/Slave
Communications

To enable host/slave communications for models 150, 160, and 240E, protocol 80 must be loaded
on an available communications port. To set the Node ID, click the Advanced button on the
Communications Protocol dialog box for protocol 80.

The required hardware configuration is shown in the figure below. Datapanel #1 is connected to the
controller via the COM1 port running the protocol appropriate to the controller. The COM2 port on
Datapanel #1 is connected to the comm port on Datapanel #2. With Host Comms enabled,
Datapanel #2 can now communicate with the controller, using Datapanel #1 as an intermediary.
Datapanel #1 and Datapanel #2 can be configured with different displays, alarms, etc. This will
allow the user to put the Slave protocol (80) on a port (either COM1 or COM2) to respond to the
Master Datapanel, which has the Master protocol (15) on one of its ports.

When Host Comms are enabled:

•  The Datapanel #1 (RTU Slave) communications protocol (protocol number 80) must be on the
port attached to Datapanel #2.

•  The Datapanel #2 (RTU Master) communications protocol (protocol number 15) must be on
the port attached to Datapanel #1.

•  The port settings for both Datapanels must match.

•  An additional window will appear for entry of a Node ID for Datapanel #1.

•  Transfer of controller information between the master Datapanel and the slave Datapanel is
restricted  to bits and registers from the slave Datapanel’s internal tables. This restriction is
necessary in order to enforce a consistent mapping between the storage locations in the Slave
for analog and digital values and those locations in the Master.

•  Reading analog values by the Master from the Slave requires configuring the input/output
addresses of the analog tag in the Master to access Holding Registers (see next section) in the
Slave. Similarly, reading digital values by the Master requires configuring the input/output
addresses of the digital tag in the Master to access Coils in the Slave. The Holding Register or
Coil designated in the Master is mapped one to one with the internal registers and bits in the
Slave. The corresponding tags in the slave are configured to use the internal bit and register
tables.

Figure 9-1.  Configuration for Using Host Communications
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Figure 9-2.  RS232 Wiring Diagram

Figure 9-3.  RS485 Wiring Diagram, Models 150, 160, 240E
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Loading Your Datapanel

This chapter describes the hardware setup for communications between DataDesigner and the
Datapanel and outlines how to use the Transfer utility. The Transfer utility is most commonly used
to download your database from DataDesigner to the Datapanel. You can also use it to download a
protocol file or Datapanel system software, or to upload a database from the Datapanel to
DataDesigner.

Note: Datapanels are shipped from the factory without any system software
(.cmd file).  If your Datapanel needs system software, the startup screen
displays the message “Waiting for Software.” Some models also display
“Checksum Error,” which does not indicate that there is a fault with the
panel, just that it needs a .cmd file.

If you attempt to download a database to a Datapanel that does not have
system software, a screen prompting you to load a .cmd file appears.
When you click OK, a file selection dialog listing the .cmd file for your
Datapanel model appears. When you select the .cmd file, it is loaded and
the database and/or protocol download proceeds automatically.

Hardware Setup
To transfer the database to the Datapanel, the appropriate serial port (Com1 or Com2) on the
DataDesigner computer must be connected to a serial port on the Datapanel as shown in Figure 10-
1.  The download cable provided with the Datapanel must be used for this connection. After
completing the download of the Datapanel, the system must be restored to the normal operating
control configuration using the controller cable (not supplied with the Datapanel).

10
Chapter
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Data
Designer

Data
Designer

Data Designer Computer

Data Designer Computer

Data Designer Configuration

Figure 10-1.  Datapanel Communication Configuration

Datapanel Transfer Utility
The Transfer Utility is used to

•  Download from DataDesigner to the Datapanel:

! Databases

! Protocols

! Datapanel System Software

•  Upload from the Datapanel to DataDesigner:

! Current Datapanel Database

For transfers to occur, the Datapanel must be in the Host Transfer mode. The function key F5 may
be used to put the Datapanel into the Mode screen, followed by F6 to display the Offline screen
then F5 for the Transfer screen.

When the F5 key has been re-programmed or is otherwise not available on a particular Datapanel
model, start the GoTo Transfer command in the Transfer utility (Special menu), then power cycle
the panel. The panel will come up in Host Transfer mode.

Note: Datapanel models 40, 45, 60, 65 & 85 don’t have an Offline screen. F6
goes directly to Transfer.

To display the Datapanel Transfer Utility dialog box, click the Transfer button or select
Transfer from the Datapanel menu.
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Initial Configuration

Datapanels are shipped from the factory without any system software (.cmd file).  If your
Datapanel needs system software, the startup screen displays the message “Waiting for Software.”

Note: Some models also display “Checksum Error” when system software has
not been downloaded. This does not indicate that there is a fault with the
panel, just that it needs a .cmd file.

If you attempt to download a database to a Datapanel that does not have system software, a screen
prompting you to load a .cmd file appears. When you click OK, a file selection dialog listing the
.cmd file for your Datapanel model appears. When you select the .cmd file, it is loaded and the
database and/or protocol download proceeds automatically.
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Downloading to the Datapanel
You can download a database, protocol, or system software to the Datapanel. A download transfers
a database or protocol file from DataDesigner to the Datapanel. Make the selections for the type of
download  desired before initiating the transfer.

Database
Click the Download Database check box. The current database is selected by default. To select a
different database, click the Database button to display the Select Database File dialog box. Select
the drive, directory and database file (.DTB file extension).

Protocol
Click the Download Protocol check box. If you have configured protocols for the currently open
database, they will be displayed in the Protocol – Comm 1 and Protocol – Comm 2 boxes. If you
need to select a protocol, click the appropriate protocol button to display the Select Protocol File
dialog box. Select the drive, directory, and protocol file. Protocol files have the extensions
indicated below:

Model Extension

30/35/50/55 .pcg

40/45/60/65/80/85 .pcr

150 .pcd

160, 240E .p1e
:p2e (2nd port)

System Software
Normally, you do not need to download Datapanel system software, unless for example, flash
memory has been erased or you need to upgrade to newer versions. To download Datapanel system
software, click this check box. Click the System Software button to display the Select System
Software File dialog box. Select the drive, directory and system software file (.cmd file extension).

Initiate the Transfer
When all selections are complete, click the Start Transfer button to initiate the transfer. The bar
graph will show progress and successful completion of the transfer.
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Uploading a Database from a Datapanel
This is used to transfer an existing database from a Datapanel onto the hard drive of the
DataDesigner computer. You can then open the uploaded database file (extension .dtb) in
DataDesigner and modify it. The modified database can either be reloaded into the Datapanel, or
saved under another name for later use.

To initiate upload, click the Upload Database checkbox. Click the Start Transfer button.  The bar
graph will show progress and successful completion of the transfer.

Erasing Datapanel Flash Memory
If you select Special on the Transfer Utility menu bar, the Erase Flash option is displayed. If this
option is selected, the Erase Flash Now warning dialog box is displayed. If the Erase Flash option
is confirmed, the Flash Memory in the Datapanel will be erased. The system software will be lost,
the current database will be lost, and any passwords will be erased. The option is provided so that if
the Flash memory is corrupted, it can be erased completely and the firmware then restored by
downloading the .cmd system file. This feature is only available for the Dp150, 160, and 240E.

Click the Special option on the menu bar to display the Erase Flash Now dialog box. Click the
Erase Flash checkbox to enable the erase function. To initiate the erase, click the Erase Flash Now
button.

The Datapanel will display the message: Erase via Port!

The PC will display the message: Sending FLASH ERASE message

When the flash erase operation is complete, re-install the .cmd system file, the protocol and the
database using the Download option.

Table 10-1.  Download Parameters

Parameter Type

Cable Connection Model

240E, 160 – either port

150 – PLC/PC port

3x/5x – PLC/PC port

40,45,60,65,85 – labeled
“Serial Port”

Baud Rate 19200

Data Bits 8

Stop Bits 1

Parity NONE
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Port Settings
To view or edit port settings for the
Transfer Utility, select Port from the
Settings menu. The Comm Port
Selection dialog box will appear. All
transfers to the Datapanel are fixed at
the default settings shown in the dialog
box.  Selection between Com1 and
Com2 depends on which of these two
ports is available on the PC containing
the DataDesigner software and may be
changed as needed.

The default settings for the link between
the PC and the Datapanel are:

•  Baud Rate - 19200

•  Parity - NONE

•  Port - Com 1 or Com 2

•  Data Bits – 8

•  Stop Bits - 1
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Advanced Configuration

This chapter provides detailed information about configuring function keys and bitmaps on the
graphic page.

Configuring Function Keys
Datapanel models 150, 160, 240E, 40/45, 50/55, 60/65, and 80/85 have configurable function keys.

Function keys (F-keys)  are configured on each individual page and may be unique for each page.
Datapanel models 240E, 160 and 150 support system wide (global) or task based programmable
function keys.

A key that has been configured on a system-wide basis will have the same label and perform the
same function on all pages unless:

•  The page type being displayed has that key assigned on a task basis

•  The page being displayed has that key assigned on a specific page basis.

A key configured on a task basis will have the same label and perform the same function on all
pages of that task type unless the page being displayed has that key assigned on a specific page
basis. You can configure the following types of keys:

! Display Pages as Graphic Task Keys

! Alarm Log as Alarm Task Keys – Models 150, 160, 240E

! Overview Pages as Overview Task Keys – Models 150, 160, 240E

11
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To Configure a Key

To configure function keys, choose System Keys from the Datapanel menu. The Function Key
dialog box will appear.

The dialog box has four rows of keys.
The first row represents the function key
assignments for system-wide use. The
remaining rows represent the function
key assignment for each of the specific
tasks. The number of options and the
number of keys on the dialog box depend
on the model being configured. Click the
button for the particular key that you wish
to program on either a system-wide basis
or on a task basis. The Function Key
Operation dialog box will appear.

•  Select an option from the Operation
list. (The list of available operations
will depend on the Datapanel model.) The appearance of this dialog box will change when you
select an operation type.

Write - writes operator-entered value to the tag

Jog - performs the function of a momentary pushbutton.

Toggle - causes a digital tag value to toggle between two values

Ramp - causes an analog tag value to change incrementally

Recipe Load/Transfer – loads preconfigured values into the associated tag, and/or transfers the
current values of the recipe tags to the controller (either or both operations can be selected)

Goto – goes to a specified graphic page

Macro – causes a custom-configured operation to be performed

 See “Configuring Output Operations” in Chapter 8 for information on configuring each of these
types of functions.



GFK-1658B Chapter 11  Advanced Configuration 11-3

11 

Bitmaps – Models 160 and 240E
Bitmaps can be displayed on Datapanel models 160 and 240E. A maximum of 300 bitmaps can be
displayed depending on the amount of available memory. Bitmaps can be used in four ways:

•  Static - to form a general background (not dynamic) on a Datapanel display

•  Discrete - to indicate the state of a Digital Tag

•  Limit - to indicate that a limit for an Analog Tag has been violated

•  List - a series of bitmaps may be configured to represent values in an analog range, e.g.,
pictorial representation of a dial in various pointer positions to represent pressure readings.

Bitmaps are stored in the following directory, which is created during installation:

•  BITMAPS  These are two-color bitmaps for use with monochrome displays. A bitmap for
monochrome will be rejected if it contains a palette of more than 2 colors, even if only
two or less colors are used.

Creating Bitmaps

You can add to this library with bitmaps from other sources or you can create your own. All user
created bitmaps must be monochrome and in Windows BMP format. In either case, be sure the
bitmap meets the recommendations given in Table 11-1.

Table 11-1.  Maximum Bitmap Size

Datapanel Model Maximum Bitmap Size
(width x height in pixels)

160 239 x 48

240E 239 x 112
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Overlaying Bitmaps

Some display options allow you to specify different bitmaps for each of multiple dynamic
conditions, e.g., the four possible states of a digital tag or the levels of multi-level alarms. When the
condition requirements are satisfied, the appropriate bitmap will be displayed. The bitmaps can be
placed at different locations on the screen or they can all be placed at the same location. In this
case, they are referred to as “overlaid”. However, at no time is there more than one bitmap on the
screen at any given time. If you desire a blank screen area for some condition, be sure to specify a
blank bitmap for that condition. Here are two examples of how this feature might be used:

•  If the four bitmaps of a discrete tag were overlaid, you could cause the tag display to
progressively change from OK, to ALERT, to ALARM, to DANGER, according to the
values of the discrete tag.

•  If the four bitmaps of a discrete tag were overlaid, you could cause the tag display to
progressively change to reflect the positions of a 4-position rotary switch.

Sizing Bitmaps

After placing a bitmap in a graphic page, the size of the bitmap can be adjusted by dragging the
sizing handles. Sizing is limited to multiples of the original bitmap size in both the x and y
directions.

Initiating Bitmap Placement: Bitmap Type Selection

Click the Bitmap button to
initiate the bitmap placement

operation. Move the mouse pointer to
the location on the page where you
want the lower left corner of the bitmap
to appear and click to place the bitmap.
The Bitmap Display dialog box will
appear. Choose Static, Discrete, Limit
or List from the Bitmap Type list. The
appearance of the dialog box changes
according to the bitmap type selected.
The configuration of each type is
discussed below.

Bitmap Selection

Each of the four types of bitmaps use the same method of selecting the bitmap. After selecting the
bitmap type, under Select Bitmap, click the currently displayed bitmap. A display of the available
bitmaps appears in a scrollable window. One of the selections is a bitmap with the text "NO BMP".
If selected, the illustration will appear in the design window, but no bitmap will be displayed at run
time. This is useful for conditional bitmaps, e.g., discrete, limit, and list, in which you want some
of the activated positions to display nothing (i.e., no bitmap) when those conditions are true.
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The bitmaps available depend on the Datapanel type. The source directory is shown in the lower
right corner. The size of the selected bitmap in pixels is shown in the lower left, along with the size
in Bytes. Click on the desired bitmap and then click OK. The selected bitmap will replace the one
in the configuration dialog box.

Static Bitmap

If you selected Static, the Static Bitmap Configuration form of the dialog box will appear. Once
displayed on a page, a static bitmap does not change while the page is shown. Select the desired
bitmap as described above. Click OK. The bitmap will appear on the page.
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Discrete Bitmap

If you selected Discrete, the Discrete Bitmap Configuration form of the dialog box will appear.
You can select a bitmap for each of the digital conditions as follows:

•  Specify the tag in the Tag Name field.

•  Select Value, Alarm, or Unack from the drop-down Data Type list according to what data
you want to control the bitmap display. If value of an analog tag has been selected, only
the lower two bits of the tag value are used to select the bitmap.

•  Select the desired bitmap for each of the conditions for which you want a bitmap
displayed.

•  Click OK.

The bitmap will appear on the page in the selected location.
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Limit Bitmap

If you selected Limit, the Limit Bitmap Configuration form of the dialog box will appear. You can
select a bitmap for each of the limit conditions and bitmap for the normal (default) condition as
follows:

•  Specify the tag in the Tag Name field.

•  Click the checkboxes for Low and/or High depending on which limits you want displayed.

•  Select the desired bitmaps. The Default Bitmap is displayed when the selected tag is
within the selected limits.

•  Click OK.

The bitmap will appear on the page in the selected location.
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List Bitmap

If you selected List, the List Bitmap Configuration form of the dialog box will appear. You can
select a bitmap for a number of values and must select a bitmap for the normal (default) condition.
If none of the assigned values has been achieved, the default bitmap will be displayed. When the
value of the tag increases to the first assigned value, the bitmap associated with that value will
appear. When the value of the tag increases to the next assigned value, the first bitmap will be
removed and the second one displayed. When the value of the tag falls below the second assigned
value, the second bitmap will be removed and the first one displayed. When the value of the tag
falls below the first assigned value, the first bitmap will be removed and the default bitmap will be
displayed. Thus, the bitmap displayed is related to the value of the tag. As an example of how this
function might be used, multiple bitmaps could be overlaid to simulate the appearance of a pressure
dial with a needle position reflecting the current pressure reading. To create a list:

•  Specify the tag in the Tag Name field. The tag must be analog.

•  To add a value to the list, type a value in the field. The typed value must be compatible
with the characteristics of the tag.

•  Select a bitmap to be displayed for this value.

•  To remove a value from the list, highlight the value to be removed, and click the Delete
button.

•  Click OK

The bitmap will appear on the page in the selected location.
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Managing Bitmaps

When configuring a database, it is important to have a clear understanding of the distinction
between bitmaps in the database and those in the bitmap directory.

Bitmap Directories
A collection of bitmaps is supplied with DataDesigner. They are stored in the BITMAPS directory
created during installation. The contents of this directory will be displayed in a scroll window,
shown below, when bitmap selection is invoked. A maximum of 300 bitmaps can be displayed
depending on the amount of available memory.

Bitmaps can be added to the directories or deleted from the directories at will. Thus, you can create
your own custom collection of bitmaps. Bitmaps will be rejected if a bitmap for monochrome
contains a palette of more than 2 colors, even if only two or less colors are used.

Bitmaps in the Database
In addition to the bitmaps in the directory, you can use bitmaps that are obtained from other
sources. For instance, if you create your database by modifying one of the sample databases
supplied with DataDesigner, your bitmap list may contain bitmaps added to the database by the
creator of the sample. These bitmaps are not copied to the BMP directory; rather, they are stored
within the database.

Every bitmap on a graphics page comes from one of three places: 1) the configuration tool’s supply
of bitmaps (default BITMAPS directory); 2) another directory location; or, 3) the current database.
The bitmap scroll bar lists all bitmaps in the database and any in the selected directory.  Selecting a
bitmap from the currently selected directory will add a copy of that bitmap to the current database.
Selecting a bitmap from the database does not add another copy of the bitmap to the database.

You can perform these functions with the Choose Bitmap dialog box, which is
only accessed when a bitmap is clicked in the Configure Bitmap dialog box that is
displayed when you are placing a bitmap on a graphic page. Deleting a bitmap
from the database does not remove it from either the DataDesigner bitmap
directory or from any other user directory. This function allows you to customize
the database bitmap list for your particular database. You can add and delete
bitmaps to/from the database without exiting the active window.
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Note: The remove button is only active for bitmaps that have been saved into
the current database. The Remove button will be enabled as you scroll
through the list of available bitmaps in the Choose Bitmap dialog, and
the selection box is on a bitmap that is in the database. When it is active,
the Remove button deletes the selected bitmap from the current database
(the original bitmap on disk is unaffected).

•  Adding a bitmap directory to the scroll list. Click the directory  button. A Choose
Directory window will appear, allowing you to navigate to the desired directory. Select the
directory and click OK. ALL the bitmaps in that directory will be shown in the bitmap
display scroll bar in the Choose Bitmap dialog box.

•  Adding a bitmap to the database. From the bitmap scroll list, click on the bitmap you
want to use. Click OK. The bitmap is now part of your database (if it is not already in the
database).

•  Removing a bitmap. In the bitmap list, select the bitmap to be deleted from the database
and the scroll list. Click the Remove button.
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Troubleshooting and Common Setup Problems

Frequently Asked Questions

How do I get started?

From the File menu, select New. Enter the name of the new Database you want to create. Select the
proper Datapanel model/database type, such as the 240E, from the pull-down list. Click OK.

After clicking OK, the protocol selection dialog is presented where the communications driver for
the PLC being used is selected.

Next, configure your Tags, and then configure your Graphic Page with display objects.

These operations are discussed in Chapter 4, “Setting up the Datapanel Database” and subsequent
chapters.

Now that I’ve created my database, how do I transfer it to the Datapanel?

Go to Datapanel, Transfer. A Transfer Utility dialog box will appear. Put an ‘X’ next to “Download
Database” and “Download Protocol.”  Connect the cable supplied with your Datapanel between
COM1 on your PC and the 25-pin port on the model 150, any port on the 160, and 240E, the 9-pin
port on models 30, 35, 50, 55, and the 9 pin port marked “Serial Port” on models 40, 45, 60, 65,
and 85. If you are using a port other than COM1 on your PC, you must go to SETTINGS, PORT
and specify the correct COM port. The Datapanel must be in the Host Transfer mode before you
can download to it. On models 150, 160, and 240E, you will see “Press F1 to Abort” on the screen
when you are in this mode. You are now ready to Transfer. Select Start Transfer.

This operation is discussed in Chapter 10, “Loading Your Datapanel.”

What is the difference between the two rows of function keys on the function key Macro
Keypad on Models 150, 160 and 240E?

The upper row of keys, all of which are icons, represent the original function of the key. The lower
row (F1, F2, etc.) represents keys that you have redefined. For example, if you had a page on your
Datapanel screen and you wanted to redefine function key F5 to go to page 10, you would double-
click function key F5, select Macro, select the macro keypad, enter 10 and enter a carriage return.

12
Chapter
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The key is now redefined to go to page 10 when pressed. Suppose now that you wanted to program
another key on the same page to execute a drive out and then go to page 10. You would double-
click on the function key, select macro, select the macro keypad, press the ‘Drive Out’ icon, enter
the drive out point number, such as 01, then a carriage return, then the value you want driven out,
three more carriage returns, then you would press F5 (this is the key that was previously redefined
to go to page 10). This will save you from having to enter keystrokes that were already entered and
save you some time.

This operation is discussed in Chapter 8, “Configuring Operator Input.”

Common Problems

Why won’t my database transfer to the Datapanel?

Make sure you are using the cable supplied with your Datapanel between the Datapanel and your
PC. If you are using something other than COM1 on your PC, you will need to go into the Transfer
Utility under Settings, Port and change the port setting. Check the port parameters in the port
settings area of the Transfer Utility.

Settings must always be 19200 baud, 8 data bits, 1 stop bit, No Parity or the transfer will not work.

This operation is discussed in Chapter 10, “Loading Your Datapanel.”

Why won’t the configuration of my Datapanel toggle a bit in my PLC on and off? I’ve
checked everything and it looks correct, but still it is not working properly.

Make sure you configured the tag to read this bit from your PLC. A toggle requires not only a
Write, but a Read address as well in order to work. Double check that the same bit in the PLC is
not being accessed by another tag.

This operation is discussed in Chapter 8, “Configuring Operator Input.”

Why won’t my Read Data and Display Text Page comms block work?

In order for this to work, you must read two consecutive registers in the PLC. The first register will
contain the page number and the second register must always contain a zero or this will not work.

Note: Comms blocks are not supported in Datapanel models 30/35, 40/45,
50/55, 60/65 and 85.

This operation is discussed in Chapter 11, “Advanced Configuration.”
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Checklist for Download Failure
If you experience a failure during a download function using the Transfer Utility, check the
following items:

Check port settings
From the main toolbar, select File/Transfer. From within the Datapanel Transfer Utility dialog box,
select Settings/Port. Make sure that the port is set to whichever COM port you want to download
through on your PC.

Make sure that you are downloading the correct files
1. In the Datapanel Transfer Utility box, make sure the correct database filename appears in the

Database window under Set File Locations.  This section should contain the name of your
database and have a “dtb” filename extension added to it.  Make sure your database was
created for the Datapanel model to which you are attempting to download.

2. If you are downloading a protocol, make sure it is the same protocol your database was
configured to use.  For example, if you created a database for a Datapanel 160 to communicate
serially to a Series 90 PLC, you would have specified protocol 68 in your database and the
correct file to download would be 68.p1e.

Note: If you start DataDesigner and then open the database you plan to
download before attempting to download the database, DataDesigner
will automatically have the correct files selected when it comes time to
download.  Select File/Transfer and you will see the proper files in the
Set File Locations section of the Transfer Utility box.

3. If you are trying to download system software (not required in most instances), make sure the
proper filename appears in the Set File Locations section of the Transfer Utility box. Click on
the System Software button and select the proper file from the list. Filenames beginning with
the letter “g” are for German language system software. English versions begin with the letter
“v” for version, followed by the version number, such as 510, followed by the Datapanel
model designator. For example, the model designator for a Datapanel 150 would be 150, 24e
for a 240E, etc.

4. After verifying the correct system file is being downloaded, connect the cable to the Datapanel,
place the Datapanel in Transfer mode, and click on “Start Transfer.”

5. If download of system file still fails, perform an erase flash procedure for your model display
and try loading the system file again.

Never download files that are contained on a floppy disk
Move any floppy disk files to your PC’s hard drive first, then download them. Access time for
floppy drives is slow enough to allow the Transfer utility to time out before the download is
complete, resulting in a failed download.
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Make sure the Datapanel is in Host Transfer mode
Always make sure the Datapanel is in Host Transfer mode before you attempt any file
downloading.

Make sure you are using the download cable supplied with DataDesigner
DataDesigner is shipped with two manufacturer-supplied download cables. The cable with a 9 pin
connector on one end and a 25 pin connector on the other is to be used with Datapanel models 150,
160, and 240E. The other cable, both ends are 9 pin, are used with models 3x/4x/5x/6x and 85. Be
sure to use the proper cable when downloading files.

Note: The cable with two 9 pin connectors may not be used to download on
COM2 of Datapanel models 160 and 240E. Use a 9 pin NULL modem
to swap pins 2 and 3 in order to download on the 2nd port of these
models using this cable.

Make sure you are connected to the proper port on the Datapanel
Make sure the download cable is plugged into the port labeled “Serial Port” on models 40, 45, 60,
65 and 85. Datapanel models 30, 35, 50, 55 and 150 only have one port. Either port on the
Datapanel 160 or 240E may be used.

Make sure you are connected to the correct PC COM port
Know which Com port you are connected to on your PC and make sure it is selected in the Transfer
Utility box.

Make sure no other devices are using the same port
Make sure no other devices on your PC are trying to use the same port, such as a modem, IR port,
etc. Sometimes two different Com ports such as Com1 and Com3 share the same IRQ; a device
using Com3 can cause problems with a download on Com1.

Try to download a demo database
Try to download a demo database such as “DP160” (for a Datapanel 160), and see if it will load
successfully. If it does, there may be a problem with your database or with the protocol or system
file you are attempting to download.

As a last resort, erase flash and reload
If all else fails, perform an erase flash procedure for your model, then reload the system software.
Then try reloading your database again.

Call for Technical Support
If problems still persist, call 1-800-GE-Fanuc and ask for Technical Support.
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Technical Data

System Tables
The following tables list System Registers and Bits. Each Register contains a 16 bit value in the
range -32 768 to +32 767 or 0 to 65 535. Entries marked with an asterisk are Read Only.

Table 13-1.  System Register Table

150, 160, 240E Description

R01 - R449 User Configurable

R450 Inter Comms Block Delay

R451 - R490 User Configurable

R491

R492

R493

R494

R495

R496

DATE AND TIME REGISTERS

Year 0 – 99

Month 1 – 12

Day 1 – 31

Hour 0 – 23

Minute 0 – 59

Second 0 – 59

R497 *

R498 *

R499 *

R500 *

R501

Value:

000

001-100

101-105

201-300

400

ERROR STATUS REGISTERS

Last system error detected

Number of system errors detected to date

Last communications error detected

Number of communications errors detected to date

Set to Number of Current Page

Values have meaning as follows:

Mode Menu, Off-line and Logo

User Pages

Overview - upper level

Overview - lower level

Alarm Log

R502 - R550 Reserved for System Use

13
Chapter



13-2 DataDesigner Software User's Guide – November 2001 GFK-1658B

13  

Table 13-2.   System Bit Table

150, 160, 240E Description

B0001 through
B0898

User configurable bits

B0900 Global Alarm bit

B0901 through
B1000

Demand bits, reserved for Comms Blocks (e.g., bit 901 drives comms block 1,
bit 902 drives block 2, etc.):

150, 160, 240E

901 1

| |

1000 100
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Registers and Bits

Datapanel Register Table

Raw analog variables can be stored in the Register Table. Up to 550 registers are available in
Models 150, 160, and 240E.  They are referenced as R001 to R550. Each Register contains a 16 bit
value in the range -32768 to + 32767 or 0 to 65535 inclusive. Registers can be used in pairs to
contain a signed 32-bit integer, unsigned 32-bit integer, or 32-bit IEEE floating point.

Registers R001 to R490
Available for configuration by the user.

Register R450
This register sets the delay period between Comms Block retries.  The register value does not
represent an absolute time period.  The time delay is proportional and is dependent on system
loading.

Registers R491 to R496
Real Time Clock Registers. These registers are updated by the system software.

Registers R497 to R498
Standard Error Codes. Register 497 contains the last standard error detected and Register 498
contains the number of system error messages to-date.

Registers R499 to R500
Comms Error Codes Registers. Register 499 contains the last error message detected and register
500 contains the number of the comms errors to-date.

Register R501
This Register is set to the number of the current page as follows:

Models 150, 160,
240E

Page

000 Mode Menu, Off-line
and Logo

001-100 Pages

101-105 Overview upper level

201-300 Overview lower level

400 Alarm Log
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Datapanel Bit Table

Raw Digital values are stored in the Bit Table.  Up to 1000 bits can be stored in Models 150, 160,
and 240E, referenced as B0001 to B1000.

Although bits B901 to B1000 can be used, this should be done with caution as they are related to
Demand Comms Blocks (refer to Demand Bits on next page). When these bits are set, they are
immediately reset to 0.

The remaining System Registers and Bits may be read from and written to. They should be
configured with caution and by an experienced user.

Bits B0001 to B0898
User Configurable.

Bit B0900
Global Alarm Bit. Set when any tag goes into alarm.

Bits B0901 to B1000
Demand Bits. These bits are reserved and operate as trigger bits for comms blocks in the range of 1
to 100. When these bits are set, whether by input from the controller or by Operator Drive Out, the
corresponding comms block is activated immediately, once only, and independently of the current
comms block operation.

Note
Datapanel Models 3x/4x/5x/6x/8x do not have comms blocks or bits.

A Demand Comms Block is given priority over currently executing comms blocks, the normal
frequency of which is not affected. Using a Demand Comms Block, a controller can initiate
communications to another controller, for instance.
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Error Codes

Communications Error Codes

The databases for Datapanel models 40/45, 60/65, and 80/85 contain a preconfigured analog tag,
COMMS_ERR, which can be put on a page to display the error codes.

101 Timeout

102 Checksum Received Error

103 Bad Character Received Format Error

104 Bad Message Framing Error

105 Bad Message Format Received

106 NAK Response Received

107 Comms Block Format Error

108 Invalid Command

Controller Errors

If any errors are displayed which are not listed in the above tables, reference should be made to the
controller text file for information.
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